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Networks and the effects 
of using them 

Why this unit matters
Computer networks help us to organise our data and to access information much more efficiently than simply 
using stand-alone computers.

Junaid works for All Computer Supplies Inc. – the company for which you produced an information sheet in 
Unit 1 – and is responsible for setting up computer networks. There are many different types of networks, and 
even stand-alone computers will link to other computers when using the internet. Junaid has to deal with all 
sorts of enquiries about the networked systems that All Computer Supplies Inc. helps to put together.

Here are some of the enquiries that Junaid deals with:

Your practical task
All Computer Supplies Inc. has decided that it would be helpful if the company developed a series of webpages 
to provide details about how networks operate in personal and business environments. The company has asked 
you to tackle this task.

I access the web all the time: playing games, using VoIP to call my friends and 
downloading music. I also love blogging and tweeting. It just happens through 

Wi-Fi and Bluetooth – but I don’t know how it works and would like some 
ideas on how I can apply it to my business. (Interior designer)

Our school has a large network. I don’t know how it works but I overheard 
someone talking about LANs and WANs. I’m not sure what all that means. I’d like to know 

– after all, I am the head teacher! (Head teacher)

I work in a shop and I know that when I scan an item at the till, all sorts of 
things happen. My till connects with the ordering department, the warehouse, payment and 

customer loyalty records. It seems as though I’m part of 
a really big network. Is that true? (Cashier attendant)

I’m setting up a network at home so that the whole family can use the same printer and 
access the internet at the same time. It will be so much easier for me to do online banking 
and make bookings for theatre and travel tickets. How does my network connect with the 

business networks when I book my tickets or make a payment? (Parent)
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What this unit covers

4.1 An introduction to computer network hardware

4.2 Computer networks

4.3 The internet and intranets

4.4 Computer networks in business environments (1)

4.5 Computer networks in business environments (2)

4.6 How does ICT help business and personal communication?

4.7 Keeping computer network data confidential and secure

Theory review

4.8 An introduction to website design

4.9 Using HTML to create webpages

4.10 Using website authoring software [1]

4.11 Creating stylesheets using website authoring software

4.12 Using website authoring software [2]

4.13 Testing and publishing a website

Practical review
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By the end of the theory sessions you 
will be able to:

 � describe the use of various devices used to set up 
computer networks

 � describe the use of Wi-Fi and Bluetooth in networks

 � define the terms LAN, WLAN and WAN, identify their 
characteristics and note any differences

 � identify a variety of methods of communication over 
networks

 � describe the advantages and disadvantages of the 
internet and intranets in business environments

 � understand the advantages and disadvantages 
of accessing the internet using different types of 
computer

 � understand and explain the need to use IDs and 
passwords

 � understand and explain the need for confidentiality 
and data security on computer networks

 � identify and explain the need for encryption and 
authentication techniques.

In the practical sessions you will 
develop and apply skills in:

 � applying the theory of web development layers in 
your work

 � website authoring and understanding the basics of 
HTML

 � combining text, images and numeric data in your 
work

 � using stylesheets to improve the look of your work

 � how to test and publish a website.
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An introduction to computer 
network hardwareSESSION 4.1

Background

Computer networks enable computers to communicate with each other 
and share data and information. There are many different types of computer 
networks. In this session, we will look at the hardware needed for computer 
networks. You may recognise some of the technical terms associated with 
networks in this session and you will find some detail about how the hardware 
devices enable communication and the transfer of data.

Hardware devices

Component Description

Routers A router is a device that connects, by forwarding packets between, 
different computer networks. It manages the data packet by:

 � deciding where it is going and the most efficient route to take by searching 
for and building a database (or routing table) of nearby IP addresses

 � deciding whether it should be transmitted or an alternative route 
should be taken

 � formatting, or translating, it to a similar protocol, so that it can be 
accessed by the receiving network.

Because routers can join very different networks together, one of the most 
common uses of a router is to connect a home or business network to the 
Internet.

Hub or Switch When connecting to the same network, computers, printers and storage 
devices are plugged into a hub or switch. A hub joins together computers 
in a network so that they can share files and an internet connection. 
It sends data packets to all computers on the network. A passive hub 
simply broadcasts or sends the signals. An active hub makes a signal 
stronger as it sends it on.

Switches are able to look at a data packet, target the computer for which 
it is intended, and send it. This helps to speed up data transmission in a 
network.

Bridges 
Stock database

Bridge

Manufacturing
departmentAdmin network

In large companies, it is sometimes necessary for workers in one area 
to access data from other areas. In a bank, for example, the loans and 
insurance departments might need to look at a customer’s account 
details to check their account history.

 � A bridge allows different networks to communicate with each other.
 � In all connections with another network, the data packets that pass 

between the networks must be in the same format.
 � Because of this disadvantage, most modern networks use routers, not 

bridges.

NIC The NIC enables the computer to link to the cable or to radio waves used 
to communicate across the network. If you look at your computer, you 
can see the socket into which the network cable can be inserted. If your 
computer already has Wi-Fi, it will have a wireless NIC built in.

Data is often transferred in quantities 
called data packets. This is how most 
data travels over the internet (and in 
recent years, also over mobile phone 
networks).

Language
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Component Description

Wireless technology Wireless technology allows devices to be connected to a network without 
physical wires, instead using radio transmitters and receivers. Two 
popular systems are Bluetooth and Wi-Fi, although both are designed 
to connect devices without wires; they are designed for slightly different 
purposes.

Bluetooth technology is limited to a short range of metres and generally 
used to link and transfer data between mobile devices, smartphones, and 
computer peripherals like the keyboard, mouse and printer. This ability 
to directly connect devices means Bluetooth has become a common 
protocol that manufacturers licences to add to audio products that would 
benefit from audio connectivity.

Wi-Fi technology has a much wider range, able to transfer large amounts 
of information and used with larger computer networks and devices as 
described in the next session. This ability means Wi-Fi is often used to 
connect devices to the internet.

Modems A modem is a device used to connect to the internet via a phone line. It 
converts the analogue signal from the phone line into a digital signal your 
network can understand and vice versa. There are three types of modem:

 � Cable modem: connects via a coaxial cable that links to a high-speed 
network designed to transmit television channels and internet.

 � ADSL modem: uses traditional copper telephone lines to send and 
receive data fast enough for modern internet requirements.

 � Dial-up modem: rarely used as broadband speeds have increased, but 
again uses traditional telephone lines to connect to the internet but 
limited to very slow speeds.

Communicating across a network
There are two different ways of transmitting data around a network: cables or 
wireless transmission. A wireless network will use radio waves to communicate.

Choosing media
The choice of cables or radio waves will depend on four factors:

1 The speed of data transmission 
required

Large computer networks are more likely to use cables because they allow 
a greater rate of data transfer.

2 The size of the computer 
network

Too many users on a wireless network will slow the speed of data 
transmission.

3 The distance that data will need 
to travel

Most NICs can only send and receive radio signals over relatively short 
distances.

4 The need for portability of 
devices

Laptop or netbook users might want access to the network as they move 
around. This might not be possible on a wired network, so radio waves will 
be used on a wireless network.

Evaluating internet-connected devices
Users can now access networks and the internet using a variety of devices. Each of the following has 
advantages and disadvantages and end-users must consider which would be the best for them.

 � Laptop computer
 � Desktop computer
 � Tablet computer
 � Mobile phone.

Read the information in the hardware 
devices table. Give reasons why a chain 
of supermarkets would find a router more 
useful than a bridge.

Activity 1
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There is also a choice in the type of cable that can be used:

Twisted pair cable

This cabling usually has four pairs of copper wire. Each pair is twisted together.

The pairing and twisting reduces interference caused by other electrical cables.

Fibre optic cable

Fibre optic cables carry data as light signals. This means that data can be 
transmitted very quickly. Light signals are not affected by interference. Fibre optic 
cables transmit far more data more quickly than twisted pair cables. This means 
that the data can be transmitted at a faster rate – more data is transferred each 
second.

You should now be able to:
 � describe the common network devices (routers, modems, hubs, 

bridges and switches) and the use of Wi-Fi and Bluetooth in 
networks

 � explain how network communications devices can be used in 
business organisations

 � evaluate network and internet-enabled devices based on  
end-user requirements.

Review and revise

1 A school has two ICT classrooms, 
one with fixed desktop computers 
and one with tablet computers. 
Explain the advantages and 
disadvantages of each during 
lessons requiring internet based 
activities.

2 A mining engineer is using 
a hand-held device to scan 
materials extracted from a test 
dig. She also needs to transmit the 
data to the laboratory that is up 
to 200 metres away. Explain why 
the system would communicate 
using radio waves and the devices 
that would be required.

Activity 2

An international bank needs to 
communicate with its branches in 
different countries. What advantages 
would the bank find in using fibre 
optic cables, rather than twisted pair 
cables or wireless transmission?

Activity 3

Interference can disrupt the 
transmission of data packets. This 
may be high-voltage electrical cables 
running along side network cables, or 
wireless signals clashing with devices 
using the same broadcast frequencies 
such as portable telephones.

Language
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Computer networks
SESSION 4.2

Background

There are different kinds of networks designed to meet different needs. In this session, you will look at three 
main types of computer networks and their advantages and disadvantages.

Internet Service Providers (ISPs) and setting up a home network
Both home and business users require computer hardware, browser software, local wiring infrastructure and 
an Internet Service Provider (ISP) to connect to the internet. Users will have their own hardware computer 
systems and browser software, and the availability of either traditional copper wires or fibre optic cabling will 
depend on their location. An ISP will provide a modem or router to allow users to connect their hardware to 
the internet through the available wires. The modem or router will connect to the ISP’s own servers and, for a 
monthly or annual fee, users can access the internet through them.

Providing internet access to multiple home devices and allowing them to connect to one another also requires 
creating a small network. One of the most common ways is using a wireless router – an easy way to share 
information if all devices have wireless technology. Alternatively a small LAN (see below) can be set up. Most 
operating systems will automatically create a small home network; linking all devices to a network name and 
using a common wireless key between them.

Internet browser and email software
Browser software converts the data from the ISP and allows users to read and view online information in a 
form not unlike a presentation or desktop publishing document. Email software sends messages using the 
internet directly from one email address to another, displaying the message in plain text to the user.

Local Area Networks
Local Area Networks (LANs) consist of computers and peripheral devices such 
as printers, all connected. It is ‘local’ because it is spread over a small area. You 
might find a LAN in a workplace or a school. Each computer in a LAN can work 
as a stand-alone computer, with its own software, and can also use software 
stored on the network server. The server runs the network operating system 
and manages resources over the network. Computers on a LAN are 
known as clients and are usually connected to the server by cables.

Types of LANs
There are two main types of local area networks: the client-server 
network and the peer-to-peer network.

A client-server network needs a server that is linked to a number of 
computers. The server will be more powerful than the clients, with 
a faster processor, more RAM and more data storage. Large LANs 
could have more than one server to provide a more specific service 
to the clients on the network. There are three very common types.

 � File server: this stores all data files created and used by the 
organisation. Users access all files by sending commands to the file server.

 � Database server: provides multiple user and computer access to a large, singular database server.
 � Print server: on larger networks, a print server will manage all jobs sent to a network printer. This allows 

the computers on the network to work more efficiently.

In a peer-to-peer network, every computer can communicate directly with other computers on the network. 
Access speeds can fall dramatically if the network has more than 10 clients. They are more common in small 
businesses and within departments in large organisations.

The diagram of a LAN below is a 
ring network. Refer to page 156 for 
information on network topologies.

Tip

LAN

Internet

Server

Router

Printer

Client
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Read the following statements and identify whether they are true or false descriptions of LANs:

1 LANs are made up of computers and peripherals that are connected.

2 Computers in a LAN can only communicate with the file server.

3 A client in a LAN cannot be connected to its own printer.

4 Servers are usually more powerful than the client computers in the LAN.

5 File servers store all the data files created and used on the LAN.

Activity 1

Advantages and disadvantages of LANs compared with stand-alone computers

Advantages Disadvantages

Users can:
 � access their own files from any computer
 � share files and software
 � work together on the same document
 � communicate with each other by email or instant 

messaging.

The cost of setting up a LAN is much higher than just buying 
stand-alone computers, due to the cost of the server and its 
maintenance. The extra cabling can be expensive. It is also 
likely that attached peripherals will be larger and therefore 
more expensive.

It is often cheaper to buy a software licence for a number 
of machines than to buy software for each computer.

Viruses can spread more easily from one computer to another 
than using stand-alone computers.

Access rights can be controlled centrally. A user could log 
on to a personalised screen and have access to certain 
files but not to others.

Changes may be made to a document, but another user 
may end up working on an earlier version of the document, 
causing problems.

Users can share hardware devices. Larger, faster and more 
economical printers can be attached to the network rather 
than having smaller printers attached to each client. This 
also makes it easier for the organisation to monitor what 
and how much is being printed.

Passwords may not be secure, which could mean that 
restricted files are made available to users who are not 
supposed to have access to them. This could lead to data 
security problems across the whole network. If it happened 
on a stand-alone computer, only the data on that computer 
would be affected.

Computers can be maintained remotely. A technician will 
be able to log on to the server or to another client and 
reinstall software or reset passwords.

If the server breaks down, the whole network will stop 
working.

Look at the following statements. Which of them are advantages of a LAN and which are 
disadvantages?

a Data and software can be shared among many users.

b Viruses brought into one computer can be shared quickly across the network.

c Users can share printers and other peripherals.

d Software licences can be less expensive.

e Data can be corrupted because files are shared among multiple users.

Activity 2

Wireless Local Area Networks (WLANs)
WLANs are different from LANs because they use a wireless link to connect computers to the network rather 
than connecting them by cable. There are five types of components that may be needed to make the wireless 
connection possible:

 � wireless access points � wireless repeaters
 � Network Interface Cards (NIC) � routers
 � boosters (amplifiers).

In your school, teachers will have 
access to data files to which students 
will not have access. Students are 
likely to have their own work area 
that other students should not be 
able to access. All of these files will 
be accessible through a LAN with 
usernames and passwords, set by the 
administrator of the system, allowing 
teachers and student access to areas 
that are only relevant to them.

Real world
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WLAN

Internet

Server

Router

Printer

Client

Wireless
Access Point

Wireless access points broadcast and receive signals from the NICs on the network. Routers allow several 
computers to access the internet through a wireless access point at the same time. This means that WLANs 
can be used in areas where a cabled system would not be practical, such as large warehouses and hotels. In 
schools there may be a need for several wireless access points, so that when you walk around with a laptop 
it will lock on to the most powerful signal. Although communications can be maintained over a distance of 
100 metres or more, boosters are useful so that signals can be amplified. This means that a user will be 
able to work further away from an access point and will still be able to use the network. Wireless repeaters 
duplicate an access point with the same IP in a different location, increasing range.

Advantages and disadvantages of WLANs

Advantages Disadvantages

Access to a WLAN is more flexible than access to a LAN. 
Users can work anywhere inside or even outside the 
building, as long as they are within range of a wireless 
access point.

WLANs are relatively slow. Other users, and sometimes 
other devices, could interfere with the network.

Because wireless access points are also installed in 
public areas – like libraries, cafes, hotels, trains – it means 
that people can still access the internet and email from 
anywhere.

Anyone with a compatible NIC could gain access to the 
WLAN. Network managers should ensure that access to the 
WLAN is not possible without the correct password.

The distance across which computers can connect to the 
server is usually less than in a cabled network.

Sort the following list into three categories: WLANs, LANs and both WLAN and LAN.

a Users can work anywhere inside or even outside the building. d Users can share hardware devices.

b Cabling can be expensive. e  People can access the internet and their company 
emails from anywhere.

c Access rights can be controlled centrally. f You need a network interface card.

Activity 3

Wide Area Networks (WANs)
A wide area network, or WAN, connects local area networks to each other over a large geographical area. 
Each LAN connects to the WAN by means of a router or a broadband modem. The WAN could cover an 
area as small as a local district, or as large as a whole country, or even internationally. The internet itself 
is a WAN.

Routers are not essential for a WLAN. 
They are only needed if you want to 
connect a WLAN to the internet.

Tip

Session 4.2 Computer networks
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There are a number of different ways in which data can be transmitted across such a network, depending on 
the distance between one network and another:

 � high-speed telephone lines � microwave links
 � fibre optic cables � satellite links.

WANs are more likely to be used by large organisations that have branches in different countries and need to 
use all of these methods of transmitting data. Many WANs are developed specifically for large organisations. 
Others, like those set up by Internet Service Providers (ISPs), connect individuals to the internet. When you use 
the internet from home, you connect to a WAN managed by your ISP.

WAN

This can be any
distance across

the world.

Client

Server Server

Client

Server

Client

Advantages and disadvantages of WANs

Advantages Disadvantages

Multinational organisations can share 
important data quickly.

If the telecommunication links fail, then communication across a WAN 
would not be possible. It would, however, be possible for LANs to 
operate in their home countries.

Transfer of data from one branch of an 
organisation to another is faster than by 
other methods.

Viruses are more commonly transmitted through a WAN than a LAN, 
and hackers are more likely to attack servers by accessing a WAN 
rather than a LAN.

You should now be able to:
 � define the terms LAN, WLAN and WAN and the differences between 

them
 � describe the characteristics of common network environments
 � describe the advantages and disadvantages of different types of 

networks.

Review and revise

A bank has offices in Beijing, Hong 
Kong, Taipei, Islamabad, London, 
Washington and Dubai. Each office 
has its own LAN. Draw a diagram to 
show how each LAN is connected in a 
WAN. Refer to the diagram above to 
help you.

Activity 4
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SESSION 4.3
The internet and intranets

Background
The internet is an international network of computers that allows users to use 
email, browse the World Wide Web or to chat either by text or by voice.

Schools, banks and other organisations often restrict access to the internet, but 
want to provide internet-type resources and experiences to their users. They do 
this by setting up an intranet, best thought of as an internal restricted access 
network.

The internet

Websites
Internet browsers accessing the World Wide Web allow us to visually access 
some of the information stored on the Internet through websites. As of 2014 
there are well over one billion websites, each containing any number of 
webpages.

Webpages Websites

Documents that can be seen on a 
computer screen. 

May contain:
 � text � animations
 � images � video
 � sound.

Lots of webpages that are linked together by 
hyperlinks.

Clicking on a hyperlink allows a user to 
navigate between webpages in the website.

They also allow you to move to other 
websites.

Each webpage has a unique address. This address helps web browsers to find 
them. The address is known as the Uniform Resource Locator or URL. This is 
how a URL is made up:

http://www.harpercollins.co.uk/about-harpercollins/Pages/about-us.aspx

Protocol Host 
name

Domain name File path Filename

Second level 
domain (SLD)

Sub domain Top level domain 
(TLD)

http:// www .harpercollins .co .uk/ about-harpercollins/
Pages/

About-us.aspx

Look at the following web addresses. Break them down into their component parts.

The first one is done for you.

• http://images.example.com

•  http://www.examples.gov.za/example/page1

• http://examples.mycompany.org.in/example/page5

Protocol Host name Domain name File path Filename

Second level 
domain (SLD)

Sub domain Top level 
domain (TLD)

http:// images .example .com

Activity 1

The World Wide Web is also referred 
to as www, or the web.

Language

It is important that you know that 
the World Wide Web is part of the 
internet. You access the web by using 
a web browser like Mozilla Firefox, 
Google Chrome or Microsoft Internet 
Explorer.

Tip

You can recognise hyperlinks easily. 
Hyperlinks are normally shown in 
blue underlined text and can link 
to a webpage, image or any other 
computer file. When the mouse 
pointer hovers over them, it will either 
change to a small hand or a box will 
appear providing a URL to Ctrl-click 
and follow.

Real world
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Accessing the internet
Users access the internet through an Internet Service Provider (ISP). There is usually a fee for this service. Users are 
allocated login details when they sign up to an ISP, including a username and a password.

Each time a user logs in, the ISP can monitor how they are using the service. In many countries, ISPs are required to 
keep records of the webpages, websites and emails that users access and create.

There are three main methods of connecting to the internet:

Method of 
internet access

Equipment 
required

Advantages Disadvantages

Dial-up Dial-up 
modem

Usually very cheap.

Requires access to a telephone line.

Slowest connection – 56 kbps.

Telephone line tied up while the 
modem is in use.

Cable Cable 
modem

Very fast, stable connection.

Access through network owned by cable 
television company – this means that the user 
benefits from other services, such as rapid 
access to movie and music downloads.

Often only available in cities and 
towns.

Broadband 
(Digital 
Subscriber Line – 
DSL)

ADSL 
modem

Fast connection.

Always on – does not tie up the telephone line.

Fast access means that users can benefit from 
movie and music downloads.

Heavy users can find download 
and upload limits to be too 
restrictive.

The internet and networks
Networks often have many users. In order for multiple users on a network to 
access the same internet connection, a proxy server is used. A proxy server 
acts as a gateway between network users and the internet by submitting all the 
internet requests for those users and then returning to them the results of their 
requests and the information received. You can see in the diagram below that 
users access the internet through the proxy server.

The proxy server:
 � submits just one request for all the users to the router
 � can also store copies of webpages for easy access
 � restricts access to some users
 � checks the source or destination of a data packet and allows or refuses 

access.

Internet

PC

Wireless
Connection

Router

Proxy Server

LAN

2nd PC

Access to the internet is often managed by a firewall to protect users from hackers. A firewall is software that 
prevents unauthorised communication to or from the network, usually placed between the internal network and an 
external network, like the internet. A firewall restricts access by identified computers by noting and blocking specific 
IP addresses or blocking certain types of internet traffic.

Proxy means ‘stands in for’ – so a 
proxy server stands in for all the users.

Language

In some organisations, like schools, 
there are restrictions on the 
webpages students are allowed to 
see.

Real world
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Intranets
Large organisations with lots of electronic material, that needs to be accessed 
by staff, often use an intranet. In the same way as the internet, an intranet 
allows users to access web-based material, share files and send email but all 
communication and data transfer is confined to the local network. Data can be 
shared also using a WAN if required (see page 161) but data cannot be allowed 
to freely travel online onto the internet as it may be confidential.

Advantages of intranets Disadvantages of intranets

Data is relevant to the user. Limited resources when compared with the internet.

Data has been checked and validated by the organisation. Limited range of views offered.

Smaller size makes communication and searching for information 
faster. The structure will also be relevant to the organisation, so it 
will be easier for users to understand.

There is limited access to/by customers and other 
organisations.

Intranets ensure that all the material is more likely to be safe and 
appropriate.

Expensive to set up and maintain: technicians need to 
be trained to manage the intranet and staff need to be 
trained to upload material.

Internet or intranet?

Internet Intranet

The internet is an international network. Intranets are internal to companies or organisations.

The internet provides open access to many areas of 
interest.

Intranets provide information that is relevant to the company or 
organisation.

The internet is open to all users with an ISP user account. 
It can be accessed from anywhere.

Intranets can block access to the internet altogether, or provide 
limited access. This makes it much more difficult for hackers to 
access the data stored on the file server. Data is stored locally 
on an intranet, which makes it more secure.

The internet is difficult to make secure because of its size 
and because there are so many access points.

Intranets can usually be accessed only by password. Access 
points are strictly limited.

You should now be able to:
 � define the terms ‘internet’, ‘intranet’ and ‘web browser’
 � describe proxy servers
 � recognise and explain the structure of a web address or URL
 � explain the difference between the internet and an intranet
 � describe how organisations make use of the internet
 � explain why organisations use intranets.

Review and revise

Many schools have an intranet.
Describe what a school intranet can 
be used for by teachers and students.

Activity 2
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Computer networks in 
business environments (1)SESSION 4.4

Background

In this session you will look at how networks are used in finance departments, school management systems 
and booking systems.

Networks in finance
Finance departments in organisations process a wide range of inputs and outputs. They:

 � handle payments for materials that have been ordered
 � send invoices to customers who have bought goods or services
 � order new materials when stock gets low
 � pay the company’s employees
 � deposit the money coming into the bank
 � calculate how well the company is doing.

The finance department in Ace Enterprises has five areas of work:

1 Payments 2 Invoicing 3 Orders 4 Payroll 5 Banking.

The finance department also has its own LAN linked to other LANs in Ace Enterprises.

For payroll and invoicing, the finance department uses batch processing.

Payroll
Ace Enterprises pays its employees on the last day of each month. This means that they can prepare their job 
queue in advance and process the job overnight, so employees are paid on time. Therefore, batch processing 
has a number of advantages for a business:

 � Processing can all be done at one time when there are fewer demands on the network.
 � Jobs are completed before processing, so no further input is needed.

The payroll system calculates wages, prints wage slips and sends data to the Banking area so that wages 
can be paid directly into the employees’ bank accounts.

Inputs Processes Outputs

Employee details:
 � rate of pay
 � tax details
 � bank account details
 � name and address.

Calculation of gross 
pay

Printed pay slips

Data from timesheets that record:
 � number of hours worked
 � overtime worked
 � holidays taken
 � bonus payments.

Deductions (such as 
tax and insurance)

Calculation of net (or 
take-home) pay

Updating of employee 
details file

Transfer data file to 
Banking

Wage slips (or pay slips) are paper 
documents included with wages that 
record how much money has been 
earned and how much has been 
deducted (usually once every month).

Language

Gross pay is what is earned before tax 
is deducted. Net pay is what is earned 
after tax is deducted.

Language
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Using the diagram shown, decide whether each of the 
following Payroll System LANs:

 � gets data from another LAN
 � sends data to another LAN.

1 Employee Personal Files

2 Tax and Pensions

3 Payslip Printing

4 Timesheets

5 Management Reports

6 Banking (BACS)

Activity 1

Print
pay slips

Deductions (tax
and pensions)

Transfer data
to Banking
for BACS

Management
reports

Update
employee �le

Make back up
copies of

payment data 

Make back up
copies of

employee �le

Payroll
System

Data from this
month’s

timesheets

Data from the
employee �le

School management systems
Excelsior Academy has a LAN that provides online processing for teaching and learning. Printing is handled 
by a printer server. All classrooms are attached to the teaching and learning network, to which students and 
teachers have access. Teachers keep their teaching and learning materials there. Students can access these 
and have space to save their own work.

Administration and management systems are managed using a separate LAN. Teachers log on to the file 
server for the School Management System (SMS). Students are not permitted to access this system.

The Excelsior Academy’s SMS has seven modules:

1 School library

2 Human resources

3 Site management

4 Finance

5 Assessment, student progress, data registration and attendance

6 Admissions

7 Administration and reporting to parents.

Teachers can access class registers to record attendance at the beginning of each day, as well as attendance 
at each lesson. Teachers can also enter assessment data from classwork and examinations. The head 
teacher can access the data that teachers have entered to see how well the school and its students are 
doing.

Why do you think students are not usually permitted to access the school management system and what measures should be put 
in place to control access?

Activity 2

Booking systems
Many theatre and cinema booking systems use online processing to allow users to communicate with a 
central computer system, which stores data about all the seats that are available for shows, events or films. 
A cinema booking system uses online processing and is likely to have a WAN.

Customers log on to the cinema booking website and follow these steps:
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Customer Cinema booking system

Chooses cinema they want to visit Cinemas appear as a drop-down list to make selection easier.

Selects the date they want to visit Finds opening and titles of films available on that date.

Chooses the film Film titles appear as a drop-down list to make selection easier.

Chooses the time of the screening Database is searched to see if there are seats available.

Decides where they want to sit Seat choice offered. Seats are temporarily reserved until customer pays, which 
means that no one else can choose those seats. If the customer decides not to 
book them, the seats become available again.

Enters personal details to confirm 
the booking

Checks to see whether or not the customer is a returning customer or a new 
customer. For a returning customer their details will be used for the booking. 
New customers will have to enter their details.

Selects payment method and 
makes the payment

Checks the payment card details and authorises payment details with 
customer’s bank.

Seats confirmed as booked – now no one else can book them.

Details of booking are shown on-screen. Customer is given a reference 
number.

Prints email as proof of purchase An email is sent to the customer as a record of the transaction.

Goes to the cinema and uses 
payment card to collect the tickets.

Checks details of payment card against transactions. If there is a match and 
tickets are not yet printed, then the tickets will be printed. If there is no match, 
the customer would need to see someone at the cinema with their proof of 
purchase or reference number.

Booking system advantages:
 � Individual seats and showings can be booked.
 � Payment can be made online.
 � You don’t have to visit the cinema or theatre to book.
 � Returning customers can have their details and preferences saved.
 � Knowing advanced numbers means cinemas and theatres can plan ahead.

Booking system disadvantages:
 � Events and showings can become booked up more easily and faster.
 � Not having internet access can mean you miss out.
 � Some people prefer to book in person.
 � An internet or system failure during booking can result in duplicate, 

cancelled or doubled bookings.

You should now be able to:
 � describe the advantages and disadvantages of booking systems.

Review and revise

Booking systems are also used for 
transport and accommodation. 
Booking flights, trains or buses 
is more complicated because the 
customer has to make various choices.

Tip

1 What is the advantage of the 
cinema having a WAN?

2 Mr Lewis wants to book a room 
in the Excellent Hotel in Hong 
Kong for two nights. He wants 
a double, non-smoking room, 
with a harbour view. There will 
be two people in the room. He 
wants breakfast in the morning. 
Use the cinema booking system 
as an example and describe the 
booking process.

Activity 3
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Session 4.5 Computer networks in business environments (2)

Background
In this session, you will look in more detail at networks in banking, 
medicine, weather forecasting, libraries and expert systems.

Banking
ICT is an important feature of the banking industry. Banks receive 
and send money by electronic funds transfer (EFT). When an 
employee receives his or her salary, or when you make a payment 
at a supermarket checkout, funds are moved from one account to 
another.

As banks have branches throughout a country, and may have 
international branches, they will have a WAN that utilises real-time 
processing.

A bank branch will have its own LAN, where ATMs (automated 
teller machines – see Sessions 2.1 and 3.3), terminals at each 
counter and office computers will all connect with the fileserver. 
Each LAN will connect to the WAN, so that people can get access to banking from ATMs wherever they are.

Customer Network operation

Inserts card into ATM. Details read from magnetic stripe or embedded chip; contact is made with WAN 
fileserver; customer offered choice of language if appropriate.

Enters PIN by using the 
keypad.

Card checked; is it valid (does the card number exist, has it been stolen or is the expiry 
date passed?)

PIN checked; is it correct?

Chooses from these options:
 � Get money
 � Change PIN
 � Mobile phone services
 � See balance.

Decides to withdraw money, 
with or without a receipt.

System offers choice of cash amounts. There may be a message about the cash 
available ‘Only multiples of £20 …’.

Selects an amount or types in 
their own choice.

Customer account file is accessed; is there enough money in the account?

Are they asking for more than their daily limit?

If there is not enough money in the account, or the customer is going beyond their daily 
limit, other options will be given ‘You have £50 available …’.

Takes back the card. Transaction completes (money is dispensed or denied); customer account is updated.

Takes money (and receipt if 
requested).

Receipt is printed if requested.

Banks also have their own intranets (distributed across their WAN) so that staff can communicate with one another 
and so that products and services can be explained and demonstrated to customers when they visit the branch.

Advantages of banking systems Disadvantages of banking systems

Money can be accessed from anywhere in the world 
where there are ATM machines.

Banks aren’t familiar with local customers, increasing 
the chance of fraud.

Balances and transactions can be done remotely using 
the internet and mobile phones.

Fraud can be carried out electronically from anywhere.

Payee

Payer
bank

Payee
bank

Payer

Electronic funds transfer

Payer
sends
transfer
request to
own bank.

Payee
bank
noti�es
deduction
of funds.

Payer bank
transfers
funds to
Payee bank.

Payee
bank
noti�es
Payee of
new funds.

(continued )
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Advantages of banking systems Disadvantages of banking systems

Money can be moved between accounts quickly. Those without access or computer systems can miss 
out on facilities and special offers.

Payroll dates can be set to benefit the employer and 
employee.

High street branches are often no longer required, 
affecting local communities.

Accounts can be monitored to look for suspicious 
activity.

Computer problems and power ‘black-outs’ prevent 
customer access.

Medicine
Dr Hallan works at a medical centre with four other doctors. They have a receptionist, who deals with entering 
details of each patient’s appointment into the computer, and a pharmacy where patients can pick up their 
medicines. When seeing a patient, the doctors use their computers to access the file server and download 
the patient’s file. Afterwards, they make changes to the file and save it again.

If medicines are prescribed, the doctors send an order to the pharmacist, 
who checks the stock on the computer and gets the order ready. If another 
appointment is needed, the doctor lets the receptionist know. The network 
allows the doctors access to a hospital network so that patients can be referred 
to specialists for hospital treatment if necessary.

Weather forecasting
In order to record and predict weather patterns, weather stations are placed across the world. Each weather 
station uses sensors and measuring equipment to record atmospheric measurements including: temperature, 
air pressure, humidity, wind speed, direction and rain fall. Live, or regularly recorded, analogue data (See 
Session 2.1) is converted to digital information and then collated by national weather organisations. Each 
station will have its own small network but also connected to a much larger central network that in turn allows 
external networks to connect and analyse the data produced.

Libraries
A computer network in a library will have one file server that contains a data file 
of the books and one that has details of library members. If a library does not 
have a copy of a particular book, other library networks can be contacted and 
the book can be ordered from them.

Libraries often use barcode readers and online processing to access data from 
the book data file and the details of library members. When a library member 
wants to borrow a book, they hand over the book and their membership card. 
Books and membership cards often have barcodes printed on them. These 
identify the book and the member.

There are other ways of accessing information electronically:
 � magnetic stripes (often seen on bank cards)
 � chips (also often seen on bank and SIM cards)
 � thumb or fingerprints (to identify people).

Input Process Output

Membership card 
scanned

The member’s file is accessed:
 � Is their membership up-to-date?
 � Is the member able to borrow any 

more books?
 � Are there any books that need to 

be returned?

Message output to the librarian’s screen.

Book scanned Book details checked in the book data 
file.

Member file and book file are both updated. 
The book is flagged as borrowed; the date of 
return is recorded in both files.

What kind of network and processing 
would you recommend for Dr Hallan’s 
surgery? How would they connect 
with the hospital network?

Activity 1

Describe the type of network an 
international weather system would 
require and what are the advantages 
and disadvantages of allowing 
external networks to connect to the 
central processing network rather than 
individual weather stations?

Activity 2

Explain why a library would have a 
WAN rather than a LAN.

Activity 3
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The library network will also access the member’s file to check if any books are overdue for return. At regular 
intervals the library will run a batch process to find which books are overdue and to remind the member who 
has the book to return it. The network will access the member’s details if a reminder is needed.

4.
Access member

details

1.
Read next record

from book �le

2.
Is today’s date the

same as, or later than
the return date?

3.
If yes – use barcode of

book to link to member �le.
If no – go to step 1.

5.
Send letter, email
or SMS to remind

member to return book

Advantages of library systems Disadvantages of library systems

Books can be renewed electronically without visiting 
the library.

People can miss out on books if they are renewed 
remotely.

Members don’t have to remember how many books 
they have borrowed.

Fewer books are stored on the shelf for traditional 
browsing.

Renewal reminders can be sent electronically via email 
or text.

People fear that libraries may become like film rental 
businesses.

The use of thumbprints means membership cards don’t 
have to be carried.

Books can be borrowed from other libraries.

Expert systems
Expert systems collect knowledge from experts and make it available for others 
working in a particular field. People in the same field ask questions (doctors 
might be asked ‘how do you treat a particular illness successfully?’), the 
answers are put into the expert system (knowledge base) to be used by others 
(doctors, for example). Expert systems use the combined knowledge of many 
experts rather than relying on one individual. In order to work the system has to 
be carefully designed.

Simple expert systems are made up of at least four different elements:

User
interface

Inference
engine

Rules
base

Knowledge
base

The user interface is an input screen where data is collected, as well as an 
output format for the expert system.

A knowledge base is a database that contains data that is linked together so 
that ideas can be checked, stored and retrieved.

Inference engines are software that use the rules base to try to get answers 
from the knowledge base, using a form of reasoning.

The rules base is made up of ‘inference rules’ that the inference 
engine can use to apply reason and make a decision. For example, IF the country is 
in the United Kingdom AND its name begins with W, THEN it must be Wales.

Expert systems are used in medical 
diagnosis, mineral prospecting, car 
engine fault diagnosis and game-
playing computers.

Real world

A retail store might use an expert 
system to check the credit rating of 
a customer and to decide whether or 
not they can buy goods on credit:

IF the 
credit 
rating 
is 
good

AND 
the 
amount 
of the 
sale 
is less 
than 
10,000

THEN 
accept 
the 
sale

ELSE 
reject 
the 
sale

Tip

Session 4.5 Computer networks in business environments (2)
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Setting up an expert system
Expert systems rely on an accurate and extensive knowledge base. Experts contribute to the knowledge – 
they help to define what is needed to create a knowledge base.

The experts would define the knowledge base and develop the inference engine, making sure that the 
questions that people are likely to ask can be answered. They also need to test the system. Expert systems 
learn from the answers. Each answer adds rules to the rules base and adds new facts to the knowledge base. 
It is important that the user interface is designed so that users can ask the questions they need.

Advantages of expert systems Disadvantages of expert systems

Answers are always consistent. Decisions are based on what the experts have provided - there is 
no ‘common sense’ to fall back on if a question is misunderstood.

Questions cannot be ignored. All questions are answered. Mistakes in the knowledge base can lead to incorrect decisions.

Expert systems reduce the amount of time it takes to 
solve a problem.

It takes a lot of time and money to set up an expert system.

Expert systems do not need a highly-qualified 
workforce. A patient can be guided through a medical 
expert system without a doctor. This could be useful in 
areas where doctors are not available.

Operators need to have high levels of training in the use of the 
expert system so that they are able to ‘ask the right questions’ 
and guide users to the answers they need.

A car mechanic uses an expert system to check the performance of an automobile. The expert 
system identifies that the exhaust gases from the engine fail to meet new standards for emissions. 
The car needs a new part to be fitted. The mechanic uses a computer to get information about the 
work done on the car and about the part. Information is sent to other departments for action.

Identify which tasks will be done by the mechanic and which will be done by the service 
department’s receptionist or by the finance department.

Task Mechanic Service 
Reception

Finance

Identify other work that has been done on 
the car – has this been a problem before?

Check that the part is in stock.

Find the price of the part.

Inform Finance how many hours the job 
will take.

Calculate the price of the job (parts + 
(hours × hourly rate)).

Contact customer to inform them of the 
required work and how much it will cost 
them.

Book the car in for the work.

Activity 4

You should now be able to:
 � use the terms LAN, WLAN and WAN in a number of contexts
 � describe the advantages and disadvantages of:

 � banking systems � library systems 

 � weather systems � expert systems.

Review and revise

In a medical expert system, doctors 
are asked to contribute all they know 
about symptoms and conditions so 
that effective diagnoses can be made.

Real world

A doctor would also apply their 
own experience and expertise when 
considering the results from the 
system.

Real world

An expert system linked to a computer 
network would be helpful to a car 
mechanic, who would be able to 
access the server for data about 
the car, and to check with the parts 
department if replacement parts are 
needed. The system would also connect 
with the finance department to work 
out the bill for servicing the car.

Tip
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Session 4.6 How does ICT help business and personal communication?

Background
In this session, you will learn how ICT and computer networks support and improve business communication.

Methods of electronic communication

Email
The most common method of communication in a business context is email.

All email applications allow users to:

Send Receive

create messages open and read messages

choose recipients – either from an 
address book of regular contacts or by 
typing the email address in

download, save and read attachments

attach files identify the sender of the message 
and save their address in their regular 
contacts address book

send messages save and organise their emails 
in folders.

Setting up an email account
Email addresses come in two parts: the name of the user and the location of the 
account on the internet. ISPs will offer users an email account and give them an 
email address, which will look something like this: mrchangis@home.net

Username or User ID @ Location element Domain type

mrchangis @ home .net

Most businesses will have an email address linked to their website domain name, therefore the location 
element of the email will show the name of the company. For example, Amir works for a company with the 
website address of www.csinc.za.com so his work email address is amir@csinc.za.com. His personal email is 
from a free email service that he can access on the web or from his mobile device and he chose 
amir201@gmail.com. He was able to fill out an online form to get an account and an email address. He gets 
access to his mail by entering his email address (or username) and password.

Instant messaging (IM)
One of the problems with email is that the email application has to be open for 
you to receive a message so you can read it. IM allows two or more people to 
exchange messages over the internet. Messages are transferred instantly. This 
type of communication is known as real-time communication and is often built 
into social networking applications.

Video conferencing
IM and other text-based communication methods have their disadvantages. It 
is hard to tell how someone is feeling about something, and easy for readers to 
misinterpret what you are trying to say. Video conferencing allows users to see 
each other’s reactions; it is also more personal.

Remember that both the receiver and 
sender of an email need access to 
email software but that they can use 
different types of email software.

Tip

Some email addresses have a country 
code as well. For example: .uk (United 
Kingdom) and .sa (Saudi Arabia)

Tip

If people need to make decisions 
about a project quickly, IM can 
be a much more efficient way to 
communicate with others than 
sending many individual emails and 
waiting for responses. The system is 
very similar to texting on a mobile 
phone.

Real world
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At its simplest level, all you need for video conferencing is:
 � a webcam
 � a microphone
 � speakers
 � an internet connection using a modem or router
 � a video conferencing application.

Many modern computers, laptops and smartphones contain all of these devices.

Businesses are more likely to use specialist video conferencing software that will allow them to communicate 
with several people at the same time. Despite the initial investment required, time and money is saved as 
because people do not have to travel long distances to attend meetings.

Audio conferencing
Telephone calls have always been an essential business communication tool. Audio conferencing allows 
multiple users to join a single conversation from any telephone, or internet accessible, location in the world. 
Calls can be arranged using traditional analogue telephone lines but in recent years the use of internet 
telephony and voice over internet protocol (VOIP) is increasingly popular. Using VOIP systems extends the 
range of conversations to any location with internet access that is often much cheaper than international 
land-line calls and multiple-users calls are handled with software rather than expensive fixed-line hardware.

Web conferencing
Web conferencing uses internet technology to allow multiple users from any 
internet enabled location to meet in a virtual conference room. Users can then 
share any electronic content with the others in the meeting; from text, images 
and presentations to live voice or video streams. Web conferencing requires no 
special equipment as it is usually software based although a microphone and 
web-cam are required if not part of the computer system being used.

Facsimile transmission
Facsimile or fax machines scan a document, either printed or handwritten, and 
transmit it to another machine. The original document is then printed as a copy 
of the original, leaving the original still in the hands of the sender. There are two 
methods of sending a facsimile:

Traditional physical faxing: The original document is converted into a single 
bitmap image. This image is then converted to a tonal signal that is then 
transmitted along traditional analogue telephone lines directly to another fax 
machine. Although slow, they require only a telephone landline and therefore 
useful where internet access is limited. These devices are still used to send 
important documents or signatures when there is a danger of an email being 
intercepted and the user requires a direct link to another party.

Electronic faxing: The process of scanning and transmitting any document 
to another location remains the same, but an internet connected computer, 
scanners and printer can replace a facsimile machine. This removes the need for 
a specific device and often the cost of international telephone calls can be high compared to a flat-rate internet 
connection.

1. Make a list of five freely available webmail providers for your region. How are their email addresses structured and how does it 
compare to an email address from your school?

2. Both email and facsimile machines can send a copy of a document from one location to another. Which one would be the 
most appropriate in the following situations and why?

a. Sending legal documents with a signature.

b. Sending engineering drawings from an architect to a customer.

c. Sending photos of a new baby to family members.

Activity 1

Video conferencing is sometimes 
known as electronic conferencing. 
Audio conferencing can also be 
termed as Teleconferencing, or 
Telecon.

Language

You may be familiar with Skype. This 
is a good example of how we can 
use a video conferencing application 
to communicate cheaply with friends 
and business colleagues all over the 
world.

Real world

The audio and visual quality of video 
conferencing depends on the speed 
of the internet connection. A fast 
broadband connection with a large 
bandwidth will allow for a clear 
smooth transmission. Attempting 
video conferencing over a slower 
connection or using mobile phone 
networks often results in stuttering 
sound and video.

Real world
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Make a comparative list of the advantages and disadvantages of the methods below in a business environment.

Method Advantages Disadvantages

Email

Instant messaging

Video conferencing

Audio conferencing

Web conferencing

Facsimile transmission

Activity 2

Blogs
Blogs (a shortened version of the term weblog) are personal or business online 
journals that are frequently updated. Normally free to set up and run, blogs 
offer a great opportunity to present ideas, articles and links to other websites. 
All content is presented in chronological order so that the most recent entry is 
always shown first; meaning readers can quickly see if the site is being updated. 
A blog without frequent updates will not attract regular readers. Readers can 
then be allowed to comment on the entries made, creating an interactive service 
similar to a forum.

Wikis
A wiki is a collaborative website that allow groups of users to build an online 
database on a specific topic, or range of topics. Any member of the wiki can 
add and edit content. The popularity of wiki sites depends on how reliable or 
extensive the information they present is. As with any user-generated content, 
questions about the validity and reliability of wikis will be asked and unlike a 
blog, changes or additions to the wiki do not appear in the order they were 
made, making it difficult to know when content has been changed. 

Tweets
Twitter is a popular communication application in which users communicate 
with one another using messages called tweets that work in much the same way 
a blog. Posts generally answer the question, ‘What are you doing?’ and users 
can either respond to it or post their own message. Tweets can be published 
using a computer or a mobile phone but limited to 140 characters or less, so 
users have to choose their words wisely. Twitter users have usernames in Tweets in this format: @johnsmith. 
Tweets on the same topic can use a hash tag: a key word starting with a hash symbol (#), for example, 
#igcse. Tweet readers are known as followers or ‘tweeps’.

Social networking
Social networking sites offer a way for people to communicate online in a very 
open and accessible way. Unlike group email, social networking sites allow 
users to choose to participate or not. With membership in billions, popular 
social networks include Facebook, QZone, Google+ and more professionally 
focused sites like LinkedIn.

Each social network focuses on making the experience of social networking 
relevant and enjoyable for their users. Users sign up to the network and 
describe themselves, including information such as their age, gender, likes and 
dislikes. This is called their ‘profile’.

As blog entries can be sent from 
any internet enabled location or 
mobile phone they have become very 
popular with celebrities, journalists 
and political readers as they can 
quickly put messages out to younger 
audiences. They are also used as 
a more interactive extension of 
established web sites.

Real world

Current examples of very large and 
influential wiki sites are Wikipedia (an 
online encyclopaedia) or Wikileaks (a 
political information site).

Real world

A Tweet is sometimes referred to as a 
‘micro-blog’.

Language

Many dating sites are social 
networking sites that put people with 
similar interests and backgrounds in 
touch with each other. In Facebook, 
making a ‘friend’ gives you access to 
other people or groups that you could 
make friends with.

Real world
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Businesses find social networking sites useful in other ways: they are a great place for advertising products 
and services that are likely to appeal to the target group for the social network. Some employers may 
investigate a job applicant’s ‘profile’ to see if the applicant is ‘the sort of person they want to employ’. 
Embarrassing photographs or inappropriate comments may change someone’s opinion of you. Some social 
networking sites have settings to ensure that certain areas of the site are limited to ‘friends’ only but it is often 
up to the user the ensure the right settings are in place. Dangers linked to e-safety are discussed in more 
detail in Unit 8.

Mobile telephones
Mobile telephones work by linking to a signal from a radio communication mast. 
For a constant signal, a mobile phone needs to be within 10 kilometres of a 
mast (or base station), and your mobile phone will constantly search for the 
strongest signal. When you make a call, the signal is received by the mast, 
translated ready for transmission over the Public Switched Telephone Network 
(PSTN) and then sent to the mast nearest the phone whose number you are 
calling.

Many people working in business have a mobile phone so they can be 
contacted when they are away from an office. Many mobile phones and 
smartphones enable users to access the internet and their emails and to use 
software applications.

Using the internet for phone calls
Calls made on mobile phones or on landlines can be expensive, especially if 
a business handles a lot of telephone calls or is dealing with customers from 
other countries. Voice over Internet Protocol (VOIP) uses an internet connection 
to make the telephone calls through a computer with VOIP software. As most 
broadband users have a fixed price for their internet connection, this makes the 
call essentially free, other than the standard internet costs.

Users of VOIP on their computer can either use the built-in microphone and 
speakers usually found in most modern computers or an external headset with 
microphone for greater clarity.

There are some disadvantages with VOIP, sound quality can be poor, which is 
not so much of a problem for personal calls but it can be for important business 
calls. VOIP also has some potential security issues:

 � Identity and service theft; other users could access your details and pretend 
to be you. They could also make calls that are charged to you.

 � As with all internet applications, viruses and malware can cause problems.

You should now be able to:
 � identify a variety of methods of communication using ICT, including: fax; the internet; email; 

electronic conferencing; mobile phones; internet telephony services; blogs; wikis and social 
networking websites

 � explain some of the advantages that companies can get from using a variety of communication 
techniques.

Review and revise

Describe the social networking sites 
that you have used. Explain why you 
might choose one social networking 
site over another, highlighting the 
advantages and disadvantages of the 
networking sites you choose. What 
features would you like to see in your 
ideal social networking site?

Activity 3

Call centres sometimes use VOIP. 
Many call centres consist of a very 
large room where operators deal 
with phone calls. Some use operators 
who work from home. The calls 
are received from anywhere in the 
world to the main call centre and 
are redirected through VOIP to the 
operators working from any office 
or even home. This reduces the cost 
of the telephone service, so that 
companies using this system save a 
lot of money.

Real world

List three advantages and three 
disadvantages for businesses using 
VOIP or internet telephony.

Activity 4
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SESSION 4.7
Keeping computer network 
data confidential and secure

Background
In this session, you are going to review network security and the confidentiality and security of data. More 
information specifically focussed on personal security and online systems can be found in Unit 8 on page XX.

Securing the network
Within any large organisation, and even your own school, different people have different access rights to 
certain information depending on their position within it. You may, for example, have access to your own area 
of the school network but you shouldn’t be able to access a friend’s area or records of student test results. 
The person that manages the computer network at school, setting access rights for different users, is often 
referred to as the network administrator and this is the same for any large network.

User IDs
A user ID, or username, is a short collection of letters or numbers. It should be easily remembered by the 
user and is sometimes based around their real name. The network administrator, who allocates each user 
a network user ID (or username), manages access to areas of the network. Each time a user logs in, the 
network system software begins by checking that the ID exists – if it does, then it will check to see what 
hardware and software the user can use and what files and resources are available to the user.

Look at your school user ID. Talk about it with a partner. Are your IDs similar? If they are, what rules do you think the network 
administrator put in place to create them?

Activity 1

Passwords
Most computer systems will not allow you to log on with only a user ID, as this is not very secure. To increase 
security, users are asked to create a password that has to be entered when prompted. Very often, as you 
type in a password, it will be hidden from view, often replaced by a display of symbols such as *******.

Accounts have passwords, linked directly to user IDs, so that only certain users 
can access messages or files. Passwords protect your data and are an essential 
part of any network or online account access, such as email. There are rules 
about password security: the more complex the password is, the less likely it 
will be that someone will guess it. Without a password you may not be able to 
get access to your data or the computer system.

 � A password such as a pet’s name or part of your home address is weak and 
not secure.

 � A password such as 3Xjpl957R would be harder to remember but much 
more secure, or strong.

Passwords are so important as networks with multiple users often have private and confidential data.
 � Why is it never a good idea to write down your password?
 � What helps to make a password secure?
 � Give examples of secure and insecure (strong and weak) passwords (make sure they are not ones you currently use).

Activity 2

Operating systems, computer networks 
and online accounts will often ask you 
to change your password. Regularly 
changing a password is a good 
practice as it prevents it being guessed 
or calculated by those wishing to 
unlawfully access your data.

Real world
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Keeping your data confidential
Think about a supermarket’s loyalty cards. These are cards that allow the 
supermarket to keep a record of what a customer buys while shoppers benefit 
from discounts and special offers. You might think that because your user ID 
and password protect your data, it is secure and confidential but this is not 
always the case. The loyalty card account will have details of the holder’s name, 
age, address, gender, shopping habits and other personal data and are often 
used at the same time as payment cards. You should expect that the two sets 
of data are confidential and that a link between them could not be made. There 
are rules to prevent this but there are examples of organisations passing on or 
even selling personal data. A customer gives personal details to companies on 
condition that their data is held securely and is not used carelessly or shared 
between a company’s employees who have access to the confidential data.

One of the ways in which user ID and passwords are unlawfully acquired is through 
spyware. Spyware is a computer program, usually attached as a zip file for an 
email or disguised alternative file installed without the knowledge of the user, that 
logs, records and transmits records of the activities of the user and the personal 
data their computers hold to an external location. Anti-spyware continuously scans 
a computer system for such programs, notifies the user and tries to remove it.

Data protection acts
Governments have had to act to ensure the increasing amount of data kept on 
networks is correctly handled. This has led to data protection acts being created 
all over the world and the majority follow the same principles. The examples 
below are typical statements:

 � data should only be used for the purpose it was originally taken
 � data must be kept up-to-date and accurate
 � data must not be held for longer than is necessary
 � data must be protected from unauthorised access, processing or damage
 � data must not be transferred to any country that does not offer the same 

level of data protection.

1. You have just bought a new smartphone from a store where you have a loyalty card. What 
problems might occur if the store does not keep your personal details secure?

2. Banks and finance departments are supposed to keep financial transactions confidential. 
What might happen if this was not the case?

3. Investigate the data protection act in the country you live, how does it compare to the 
example given?

Activity 2

You can protect your access to the internet, to your email account and to your 
network by having a user ID and a password. You can also protect files on your 
computer. For example, you might want to protect a document you are typing 
for homework by adding a password. This gives you an extra level of security, 
as anyone wanting to get into your document would first have to log on as you 
and then enter the password for your document.

Encrypting data
In many organisations, data is encrypted to protect it further. Banks and 
government departments, for example, insist that data is encrypted so that if an 
unauthorised user gets access to the data, they are unable to read it.

Encryption converts data into a code by scrambling it using an encryption key 
and these are then transmitted separately. Unless you have the software to 

Spyware, or a computer virus, can 
place itself onto your computer in a 
variety of ways:

 � you may receive an email which 
claims to be from a friend, but 
unfortunately is not, that asks 
you to download an attachment 
or follow a link to a website.

 � sharing portable storage, 
downloading files from the 
internet or using USB pen 
drives is an easy way for 
infected files to be passed on.

Real world

Look at the requirements that a 
government department has set out 
for its workers:

 � Laptops must use a system 
where data can be encrypted.

 � If you are using your own ICT 
equipment, you must keep 
departmental data completely 
separate from your own data.

 � Only government supplied 
pen drives can be used for 
transferring data and must be 
encrypted to a certain standard.

 � All paper data must be kept 
locked away while in your 
possession.

 � All paper data must be shredded 
when no longer required.

Real world

When you pay for goods using a 
payment card, access to your account 
is limited to only those that know 
your Personal Identification Number 
(PIN). Hopefully that just means you!

Real world

Encryption puts the data into code. 
Decryption decodes the code back 
into readable data.

Language
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‘unscramble’ or decode the data with the corresponding key, it will be meaningless. The software used to 
unscramble encrypted data is called decryption software.

Identify three advantages and three disadvantages of encryption.

Activity 4

Authentication techniques
Having user IDs in combination with passwords is an example of an 
authentication technique. Authentication techniques are used to identify users to 
a computer-based system or network. Each technique provides a range of 
methods for proving your identity, and the higher the security requirement; the 
more techniques may be used. There are three factors that can be used in 
authentication:

Factor Example

1 Something that you know  � a Personal Identification Number (PIN)
 � username ID
 � a password or phrase
 � a challenge response (you must provide the 

correct answer to a particular question).

2 Something that belongs to 
you

These items are normally provided by the 
organisation providing secure access:

 � a passport, bank or membership card 
containing a data chip

 � a security wrist band
 � a special token or key
 � a mobile phone
 � an electronic code generator.

3 Something unique 
about you

This may be biometric data from the following 
unique features:

 � fingerprints
 � voice print
 � iris or retina scan
 � facial scan.

Other sources such as your own DNA can 
be used but such a test would be time 
comsuming and expensive.

You should now be able to:
 � explain why it is important to keep data secure and confidential
 � describe the processes and practices that businesses employ to ensure that data is held securely 

and confidentially
 � give examples of data security in finance, schools, banking and in the retail industry.

Review and revise

Many schools have introduced 
payment systems that do not need 
cash when something is bought. 
Students pay money into the system 
and from then on can pay for lunch 
or other services in school by using 
something that is unique to them, 
like a thumbprint or a magnetic stripe 
card.

Real world

It is possible in some airports to 
fast-track through passport control 
by registering to use your biometric 
data. A scanner scans your iris, verifies 
that you are who you say you are and 
allows you to pass through.

Real world
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Some practice questions

What have you covered?
In these seven theory sessions, you have:

 �  identified common network devices such as routers, modems, hubs, bridges, switches and proxy servers
 � discovered how network communications, including wired, Wi-Fi and Bluetooth devices can be used in 

business organisations
 � been introduced to LAN, WLAN and WAN and the differences between them
 � considered the characteristics of common network environments
 � compared and evaluated different types of network topologies
 � considered how businesses use networks in their everyday operations and the different devices we can use to 

connect to them
 � identified a variety of methods of communication used by businesses
 � considered the benefits that companies can get from using a variety of communication techniques
 � been introduced to the terms internet, intranet, web browser and ISP, web address and URL
 � discovered the difference between the internet and an intranet
 � considered how and why organisations make use of the internet and intranets
 � considered the importance of keeping data secure and the methods that businesses employ to ensure its 

security and confidentiality.

1  Connect a term on the left with the most 
appropriate example on the right:

LAN A network across a university 
campus

WAN A network used to connect 
offices of a car hire company 
across the country

WLAN A network operating within 
company headquarters

See Session 4.2

2  Use the terms in the list to complete the paragraph 
below, which describes a school network.

client-
server

network 
card bridge

file 
server WLAN

network 
cable router

To connect a computer to a (___), your computer 
needs a (______ ____) so that you can plug in the 
(________ ____). Your school computers will be 
connected through a (______) to a (________ ____). 
This kind of network is known as a (________ ____) 
network. It is possible that although the student 

and administration networks might be separate, a 
(______) will allow data to be passed between the 
two.

See Session 4.1

3  State whether each of these statements is true or 
false.

True False

a The internet can only connect 
computers within a small 
geographical area.

b An intranet will only be 
accessed by users within a 
single network.

c A WLAN requires users to be 
connected with a fibre optic 
cable.

d An email address is needed 
before a user can access 
information on the internet.

e A WAN could be considered as 
a network of networks.

f Modems can only connect to 
the internet via fibre optic cable

See Session 4.2
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4  Explain the difference between the internet and 
an intranet. If your school has an intranet, what 
does the school use it for and explain how an 
organisation like a hospital might use one.

See Session 4.6

5  In order to keep data secure, an organisation will 
often use encryption methods when transferring 
data. Usernames or IDs and strong passwords may 
also be required in order to make sure that only 
authorised users have access to data. It is also 
common for a company to use a network firewall in 
order to further restrict access.

Explain the terms in italics.
See Session 4.7

6  Pete is a veterinary surgeon. He also runs a 
rescue centre where pet parrots, which have been 
abandoned by their owners, can be taken in and 
cared for. The rescue centre and animal hospital 
are built alongside his house. He has an office in 
his house and another in the rescue centre where 
his assistant works. All the files about the animals 

are held on a data server in the house. Pete wants 
to create a network so that he can access the data 
on his laptop as he moves around the buildings. 
His assistant also needs to be able to access the 
same data as she monitors the birds in the animal 
hospital.

a What kind of network does Pete need?

b List the hardware requirements of the system 
that Pete will need.

c Pete wants access to the internet. Explain 
why he needs an ISP. He has been offered the 
choice between ADSL and a cable modem.

d Discuss the advantage and disadvantages of 
the connection types that Pete has and suggest 
which would be the better option for him.

e Pete has been given the email address: pete@
parrotsanctuary.co.uk

 Explain what the different parts of this address 
represent.

See Sessions 4.2, 4.5 and 4.6

Progress check

Aiming for good progress
 � You are able to identify all the hardware 

components required to create a network.
 � You understand the differences between 

various network types.
 � You can describe the different ways in which 

organisations can communicate and share 
information.

 � You understand the ways in which users can 
connect to the internet and the hardware and 
software they need to achieve this.

 � You recognise that within the workings of a 
network, security and confidentiality of data are 
vital.

Aiming for excellent progress
 � You can identify all hardware and components that are 

necessary to create a network.
 � You can describe the differences between the ways in 

which various networks operate.
 � You can identify and evaluate the different ways in which 

organisations communicate with each other and how they 
share information.

 � You can describe and evaluate the ways in which 
the internet is made available to users, including the 
hardware and software required.

 � You can explain the necessity for keeping data secure 
and confidential, and you can offer suggestions about 
how this can be achieved.
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An introduction to website 
designSESSION 4.8

Background
Before starting work on the All Computer Supplies Inc. website, it is important to become familiar with how 
websites are designed and created today and the different options that are available.

Writing a page using HTML
HTML is a programming language, covered in 
more detail in the next session, which allows 
the designer to dictate content, colours and 
formatting through a text-based script. All early 
websites were created using this method and it 
is still very popular today. It requires no specialist 
software to write a page other than a basic text 
editor, and the knowledge to create it. Writing a 
script from scratch is increasingly difficult and 
time-consuming.

Web design or WYSIWYG software
As many more people became interested in web 
design, software packages were developed to 
remove the need to learn and program HTML 
from scratch. Commercial software packages like 
Adobe Dreamweaver use a WYSIWYG (What you 
see is what you get) interface, allowing the user 
to visually create a website but with access to 
the scripting language being generated behind it. 
Commercial software can be expensive but there 
are open source alternatives such as BlueGriffon.

Website content management system
Creating a website using HTML or specific 
software both require the site to then be uploaded 
to a host for viewing on the Internet. An online 
CMS (content management system) allows a 
user to log into an already constructed website 
and customise it completely to meet their own 
needs. This may include changing colours, fonts, 
images and menu systems to meet the users own 
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house style requirements. Such systems are very popular for those with little 
web design skills who would like a professional looking website online in a short 
space of time, and plan to make regular changes to their site. There is a cost 
involved for most commercial systems, and users are limited to how much the 
look of the page can be changed. As the site is already online there is no need 
for web hosting.

Search for as many example of web design software, either commercial or open source, and 
compare the features they offer.

Activity 1

Web design development layers
In order to create an effective website it is important to become familiar with the three web development 
layers. Considering these layers throughout the design, development and maintenance of a site can save 
time and repetitive work.

Content layer
Sometimes referred to as the

structure layer, this refers to the

HTML framework of a page.

This will include the visual

layout, placement of text and

images and hyperlinks used to

navigate both within the page

and to external pages.

Presentation layer
The presentation layer defines

the format of a page through

styling elements and how

it will appear to the user. This

maintains visual consistency

across browsers and platforms.

The layer is defined through

cascading style sheets (css)

that can be applied to one or

multiple pages.

Behaviour layer
Real time interactive or

dynamic content on a site that

provides users with something

to do is often generated using

JavaScript and this is the

behaviour layer. This may

include image galleries, forms,

the setting of multimedia

element sizes or adding a live

clock, video or music track. 

Choose one page from three popular websites and for each, analyse and describe the key elements that make up the content, 
presentation and behaviour layers.

Activity 2

You should now be able to:
 � identify and describe alternative methods of designing websites
 � identify and describe the three web development layers
 � understand the function of the content, presentation and behaviour layer.

Review and revise

Many people now use blogs as a 
simple, user friendly, alternative to 
web design software to create an 
online presence. Blogs are usually free 
to set up, very customisable, and offer 
many of the advantages of an online 
CMS.

Real world
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Using HTML to create and 
edit webpagesSESSION 4.9
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Background
The World Wide Web allows access to millions of websites, with more added every minute of every day. 
Stored on web servers that are interconnected via the internet, each website is made up of one or more 
websites which are linked together by hyperlinks. Webpages are created using a language called HTML, 
which stands for Hyper Text Mark-up Language that instructs a computer to display visual data in a user-
friendly format. All webpages were originally written in HTML but web authoring software that combines 
visual design tools and HTML coding are becoming more popular. These programs store their pages in HTML 
format, but developers do not necessarily need to know the HTML language to develop effective websites.

Junaid at All Computer Supplies Inc. has asked you to create webpages by following the steps in these sessions.

Beginning to create a webpage using HTML
Use a text editor to create your first page. Open a text editing program such as Microsoft Notepad and type 
in the lines of code shown here:

4  Note how the file begins 
with <html> and ends with 
</html>. 

   You will also have spotted 
the <body> </body> tag 
which indicates the main 
content, or body, of the 
page and <h1> </h1> to 
indicate the heading or title 
of the page.

1  Note the text in angled brackets <>. These are 
known as tags. Tags come in pairs and indicate 
the start and end of a section.

3  Remember that for every 
beginning there is an end: 
most tags come in pairs. 
For example, 
<p> marks the beginning 
of a paragraph and 
</p> marks the end of 
the paragraph.

2  Note the first section after the opening <html> tag is the 
<head> </head> section. Here you can name the title of the 
web page as it appears within a web browser using the <title> 
</title> tag and add linked to attached style sheets. At the 
moment it is still called ‘Untitled Document’.

Tags
Tags are used to mark up, or describe, a webpage. A web browser such as Internet Explorer or Firefox uses 
tags to interpret what the page looks like. Webpages use HTML to mark up the page.

HTML elements and nesting
Everything contained in the opening and closing tag is known as the HTML element. HTML elements can 
have other elements contained within them. This is known as nesting. In this example the <body> </body> 
element is nested within the <html> </html> element.
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You can display the file as a webpage 
by dragging the file across to the 
browser icon on your desktop or, if 
the file is shown with the browser 
icon, you can doubleclick on it 
(the .html extension will make your 
browser open).

Tip

Popular web browsers at the moment 
include:

Google Chrome
Microsoft Internet Explorer
Mozilla Firefox
Opera
Apple Safari

Real world

Save the file as Page1a.txt, a text document (.txt) in your work area. This will be 
important if you want to change it later; it is easier to edit 
a .txt file than an .html file.

Then save the file as Page1a.html. Make sure that you save the file in your work 
area with the .html extension. Now open it in a browser.

You have created your first webpage! Note:
 � The use of the file extension (.html) is crucial as the browser will not see the 

file as a webpage without it.
 � Sometimes the file extension is shortened to .htm – either is fine!

In the Chrome browser, the webpage that you have created looks like this:

As you can see, the browser does not display the tags but interprets them to show the page:
 � The browser knows that it has some HTML to display because it is contained by <html> </html> elements.
 � The main content to show is within <body> </body>.
 � The heading at the top is in big letters as the HTML indicated it is a first level heading: <h1> </h1>.
 � The remaining text is in separate paragraphs, as indicated by <p> </p>.

Structuring the content
Junaid recognises that this webpage needs a better layout. He decides it would be better if you could list the 
products he has in his shop. You change the webpage by editing your .txt file.

3  You could also try an ordered list, replacing 
<ul> </ul> with <ol> </ol>. (See Activity 1)

2  Use two new tags <ul> </ul> and <li> 
</li> to replace the paragraph element.

   <ul> is interpreted as an unordered list.

  <li> is a new line

1  By editing the <title> tag within the <head> 
section you can change the name that appears at 
the top of the page within a web browser.
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1 Save this as Page 1b.txt and then save as Page1b.html and view it in a browser. Write down any differences you see 
between the first webpage you created, and this one. What does an unordered list look like on a webpage?

2 Change your HTML coding to replace the unordered list with an ordered list. Save your file as Page1c.html so that you can 
monitor the changes you’ve made. What’s the difference?

Activity 1

Changing the look of a webpage
Junaid and you both realise that this webpage does not look very attractive. You decide to change the 
appearance of the page.

2 There are other tags you could use.

  For example, you could try <strong> and <em>. 

   Other common tags include <sup> for 
superscript and <sub> for subscript text.

1  You can place new tags around all and your.
What do you think these look like on a webpage?

 � Insert the tags <b> </b> and <i> </i>. You should find that <b> </b> makes text appear bold and that <i> </i> 
makes text appear in italics.

 � Experiment with other tags such as <strong>, <em>, <sup> and <sub> in your file. Remember that HTML elements 
have a start and an end. Don’t forget to save your file as .txt and .html. Remember also that you will need to save and refresh 
the view in your browser to see the changes.

Activity 2

Using attributes to change the look of a webpage: Colour

There are other things that you can format on the webpage by using HTML. Junaid asks you to add some 
colour to the page and then to change some of the formatting.

Try adding other colours to your page. Choose from the list of 17 standard 
colours. You must be careful to type the code correctly.

Activity 3
2  There are 17 standard colours, which all browsers 

can interpret correctly: aqua, black, fuchsia, blue, 
grey, green, lime, maroon, navy, olive, purple, red, 
silver, teal, white and yellow.

1  Look carefully at how colour is added to the 
page, using style within the tag. Style is an 
attribute of the HTML element.

 Note:

 � The spelling of color (US spelling)

 � The use of quotation marks. Used to define 
attributes in HTML. These should be at the 
beginning and end of an attribute, such as 
a size or a colour.

 � The use of spaces. Attributes are separates 
by spaces or line breaks.
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Using attributes to change the look of a webpage: Formatting
Junaid suggests you change some of the other formatting to help improve the page.

Previewed in Chrome, the page would look 
like this.

1 Type the changes into your file. Save and review in a browser. Remember the new filename! Don’t forget to add .txt and .html 
at the end.

2 Experiment with different values of the style attribute and see what happens. For example, try and replace the standard named 
colour references with their hexadecimal equivalents. Remember, you need to save the file and refresh it in the browser to see 
the results.

3 Print the HTML code of your last page and highlight it in different colours on the printout:

 a the opening and closing body tags

 b the opening and closing tags of paragraphs

 c the opening and closing lines of a list

 d the attribute of the heading <h1>

 e the value of the attribute for <h1>.

4 Answer the following questions:

 a How does a browser know that a file is a webpage?

 b  How many standard named colours are there and how many hexadecimal references can be used?

 c How can you tell if an HTML file contains a ‘nest’?

 d What are:

i HTML elements?

ii attributes?

Activity 4

All web design colours are based on 
the RGB model, mixing together Red, 
Green and Blue. Up to 16,777,216 
possible colour combinations are 
available using three pairs of two 
digit hexadecimal references in the 
format of #RRGGBB.

Real world

Note how there are different values with the 
style attribute in <body> <h1> and <p>.

The style attribute can have a range of different values and can 
be added to an HTML tag to define the content with it. The most 
common ones are:

 � font-family, which indicates the font to be used

 � font-size, which indicates the size of the font

 � text-align, which indicates whether the text is aligned to the left, 
centre (center) or right

 � font-style, which indicates normal or italic font-weight, which 
indicates bold or normal

 � background-color, which indicates the colour of the background 

 � color, which indicates the colour of the text.
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If you feel confident with your understanding of HTML so far, you can learn more 
about font-family and font-size in the Extra support folder on the CD.

Adding a table to a webpage
Using tables is a good way to organise information. Junaid would like the three 
different office locations adding to the page you have made and has suggested 
using a table. There are no drawing tools when using HTML but the following 
tags allows you to specify the structure and size of the table.

2  The table is defined using the <table> 
<table/> tags.

2  Each row is defined by the <tr> tag and 
each cell within the table is defined with 
the <td> tag.

As you can see, this table will have two rows 
and three columns.

The page will now look like this.

On the CD

Formatting a table in HTML
Once previewed, it is clear that the blocks of text in the table are quite close together. Using additional 
attributes, it is possible to adjust widths, add styling and allow a single cell to span more than one column.

255884 IGCSE ICT SB_CH04.indd   184 09/08/18   5:55 pm



PRACTICALPRACTICAL

185Session 4.9 Using HTML to create and edit webpages

1  Look carefully at how a single black border 
and left alignment has been added by adding a 
page style to the page in the <head> section.

2  Note how the width of the table can be 
defined by adding an in-line style to the 
<table> tag. This can be set as a percentage 
or in pixels.

3  By replacing the <tr> tag with <th> it now 
becomes a table heading.

The page will now look like this.

Inserting an image in HTML
Junaid would like his new logo inserting at the top of the page. He has provided you with an image file and 
has specified it should be no wider than 100 pixels, whilst still maintaining the aspect ratio.

1  Insert the <img src> tag before the main heading to add the logo. Note the additional attributes:

 � The file name of the image is located in the same location as the webpage, otherwise the file path should also be included.

 � The alt attribute provides an alternative text or description for the image, used if a user requires a screen reader.

 � The width attribute specifies the width in pixels. The height can also be specified but if only the width is set the image 
ratio is automatically maintained.

4  If a heading applies to more than one column 
then one heading can be made to span 
multiple cells using the colspan function.
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This logo should now appear at the top of the screen.

You should now be able to:
 � set up a simple webpage using HTML
 � recognise and use tags to change the appearance of a webpage
 � recognise and use attributes to change the appearance of a 

webpage
 � understand when HTML commands are nested.

Review and revise

Remember, color and center use 
American spelling when used in 
HTML.

Language
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Background
In this section, you are going to use website authoring software (or a web editor) to create and modify 
webpages. You should find this easier; you do not need to remember so much code and the software itself 
will make sure that you use the correct spelling, spaces and punctuation. As described in Session 4.8, the 
features in this section will allow you to create the content layer of the web design development process.

Beginning to work with website authoring software
You may wish to use the web editor called Adobe Dreamweaver, as used in this unit. It is available for 
Windows and Apple Macintosh operating systems and has been designed so that the webpage you create 
looks the same on all browsers using a WYSIWYG interface.

When you start Dreamweaver for the first time the screen will look like this:

It is worth exploring the menus at the top. The layout looks very similar to lots of other programs, which 
makes it easier for you to find your way around. On the right hand side, you have panels designed for 
particular tasks.

The main panel always opens with the Dreamweaver welcome page, which is useful when deciding what sort 
of webpage you intend to create.

Session 4.10 Using website authoring software [1]

SESSION 4.10
Using website authoring 
software [1]
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1 In the Welcome window, select Create New HTML page.

2 Find the icons on the menu bars that allow you to insert images.

3 Find the icons or options for unordered list, ordered list, bold and italic.

4 Find the buttons that allow you to switch between the different design views:

 a Code

 b Split

 c Design

 d Live

 e Find the drop-down menus that allow you to:

5 Find the button that allows you to preview your website within a browser window.

Activity 1

Opening a page
Junaid asks you to change some of the work that you did last session and wants you to start by opening 
Page1a.html within Dreamweaver using the Open Document icon.

The file opens in Dreamweaver and the content can be viewed in four different ways using the tabs at the top 
of the page.

Code: Displays the page purely in HTML 
mode.

Split: Shows both the HTML coding and a 
visual representation of how it should within 
a browser.

Design: Displays only a visual representation 
of the page, no HTML.

Live: Attempts to display the page as it 
would look within a browser. Note the 
content cannot be edited in this mode.

Look at the source coding. 
Note how Dreamweaver has 
used different colours to show 
the HTML tags and content.

Look at the unordered list – 
Dreamweaver has indented 
the nested tags so that we 
can identify the nests much 
more quickly.

188 Unit 4 Networks and the effects of using them
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1 Highlight the word ‘all’ in, ‘We can provide all your computer needs’.

2 Make it bold (strong).

3 Then make it italic (emphasis).

4 Highlight the list and click on the icon that will make it an unordered list.

5 Save your file as Page1a-v2.html.

Activity 2

You should now be able to:
 � open a new webpage using web authoring software
 � navigate the main functions of the software
 � open and edit a webpage using WYSIWYG functionality.

Review and revise

189Session 4.10 Using website authoring software [1]
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Creating stylesheets using 
website authoring softwareSESSION 4.11

Background
The presentation layer of the web design development process defines the look of a webpage through the 
creation of CSS (cascading stylesheets) that can be applied to one or any number of webpages. If you are 
creating a single webpage, then the styles; fonts, colours and backgrounds can be set within the website 
authoring software for that page but CSS becomes really useful if you plan to create more than one page.

Consider a mini shopping website of three pages; an external CSS file can define how each one of them 
looks. Fonts, colours and background images can be set within the stylesheet meaning changing this one file 
changes all the files it is linked to. Imagine how useful this could be with a website of ten or fifty pages and 
the task of maintaining consistency and a particular house style.

External CSS File
Defining font, colours,
size, background etc

homepage.htm

products.html

contact.html

In this session you will create a CSS file to define the presentation of the page 
you created and also apply it to pages you create in the following session.

Organisation and relative file paths
When creating any website, the organisation and location of your files is really 
important. Websites work most efficiently when created with relative file paths. This means the links between 
the files you create, HTML files, images, sounds and style sheets, are all relative to each other. By creating a 
folder structure for your website before you start, files will all have a set location and relative links will be easy 
to maintain.

Create a folder in your document area called website and within that folder create two sub-
folders called CSS and media.

   

Activity 1

The difference between attached stylesheets and 
in-line style attributes
In this session you are going to create an external CSS stylesheet that will be attached to more than one 
page within your website. This allows the rules created within the stylesheet to impact upon multiple pages, 
saving time and coding.

Try to avoid moving files within a 
website using the file explorer of your 
operating system as this can break 
the links between relative files. Always 
save and modify locations within your 
web authoring software.

Tip

Unit 4 Networks and the effects of using them190
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Alternatively, you will have already used in-line style attributes to style elements of your web pages. The key 
difference of in-line styles are that they affect every element of the page with the same style attribute. For 
example, the table styling created in the session 4.9 will affect every table in the page if more were added. 
In-line styling is useful for single web pages and creating HTML emails.

Adding a sample style sheet
Open the original file Page1a.html you created in the previous session and resave it into the website folder 
you have just created. Dreamweaver has a number of pre-installed generic style sheets that can be used and 
adapted to help experiment with using CSS for the first time.

To attach a generic style sheet, select Format > CSS Styles > and Attach Style Sheet from the main menu 
and then select the sample style sheets option.

Select the sample file called Basic: Arial and select OK. An external stylesheet has now been created and 
linked to your webpage.

Create a sample style sheet like the one shown. Experiment with editing the sample CSS styles 
and adding additional properties, observing the changes that happen within the web page. 
Once this activity is complete, remove the style sheet from Page1a.html by using the Unlink 
CSS Stylesheet option at the bottom of the CSS Styles window.

Activity 2

Select the css folder 
within the website 
folder you created

Alternatively additional properties 
can be added to styles using the 
CSS Styles window.

Fonts and sizes can be edited 
directly within the CSS file.

Like .html files, .css files can also be 
opened and edited in Notepad or any 
other basic text editor.

Tip

Session 4.11 Creating stylesheets using website authoring software
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The difference between a style and a class
Within the language of CSS styling can be applied in different ways. A style attribute can be applied to a 
specific element within the same line, often referred to as in-line styling.

A style can be attached to an id attribute of an HTML element, this means only one unique element will be 
affected. The # symbol is used to identify an HTML id element.

A class can be applied to multiple elements in the same page with the same class selector. A period (.) is 
used to identify a CSS class element.

Creating a new CSS file
Junaid would like the background of the webpage to be yellow and all the text to be in an Arial font. Creating a 
new style sheet for a website allows total control of these styles can be added to and edited at any time.

Look carefully at the code and you will recognise many common features. The element (body) is described 
by the values contained within the curly brackets { }. The names of the values are the same as those you met 
in the previous session for the style attribute. What is different is the way the colour is described. Rather than 
yellow, which you used before, it now says #FF0.

Rather than simply using sample style sheets, a new empty CSS file can be created, completed and linked to 
any number of webpages. Select File > New and select CSS from the list of page types. Once open, styles 
can be coded by hand and the table below lists two of the most common styles.

CSS Style Example Description

Body body {

font-family: Arial, Helvetica, sans-
serif; font-size: 12px; background: #FF0; 
font-style:italic; 

}

The main text will use the Arial font family, be white, 
12 pixels high and in italics. The background of the 
page will be yellow.

Table table, th, td {

width: 50%; text-align: center; border: 
1px solid #000; padding: 0px; border-
spacing: 0px

}

Any table will be 50% of the screen width with a 
solid black border with no padding or spacing.

Including the th and td tags means the styling will 
be applied to the heading and data rows of any 
table.

Attaching a new CSS file to an existing page
Having created and saved a new CSS file, it can now be attached to an existing 
web page by selecting Format from the main menu followed by CSS Styles and 
Attach Style Sheet. A new CSS file can be selected and the link option used so 
it can be attached to multiple html files.

1 Create a new blank CSS file, save it as ACSupplies.css into the css folder of your website 
folder.

2 Add body and table styles similar to the ones shown that will suit Junaid’s requirements.

3 Attach your style sheet to Page1a.html

Activity 3

Headers, paragraphs and lists
Website design conventions allow for many common elements to be specified: 
the headers, paragraph and list options are three that can be either set within 
your website authoring software or set using a CSS rule. There are six heading 
tags <h1> </h1> through to <h6> </h6> with h1 recognised as the most 
important and h6 the least. The tags for paragraphs and lists were outlined in 
session 4.9.

CSS Comments 
Sometimes it is handy to add notes 
to explain your code at a later date. 
A CSS comment starts with /* and 
ends with */ and is ignored by web 
browsers.

Tip

Try to avoid clashing header tags and 
CSS rules as all the rules you apply 
may not appear. Decide which is the 
most efficient to use for your site.

Tip
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The example below shows how to add a rule by hand to the CSS script and these headings can be used 
instead of specifying additional styles to a title or subtitle.

1 Open up the Page1a.html and its associated CSS file, ACSupplies.css and edit the CSS coding to add the h1 header rule as 
shown. Then apply this rule to the title.

2 Use the tools in the Property toolbar at the bottom of the screen to add bullets to the list and make the work all stand out in 
bold with italics.

3 Preview the page using File > Preview in Browser (Selecting the one available) and it should look like the example shown below.

Activity 4

  

Style sheet hierarchy and in-line styles
CSS styles can be applied to a HTML document either internally or externally but having multiple instances of 
styling means sometimes rules can clash and it is important to consider which element will take precedence 
over others. Although there can be issues relating to browsers inconsistencies that are often out of web 
designers hands, the general consensus is that the order of application is as follows:

Browser Default settings
(in absence of any

styling)

Lowest Priority Highest Priority

External style sheet
(attached to a

HTML file)

Internal style sheet
(defined in the
head section)

In-line styling
(adding multiple style
attributes to the same

HTML tag)

Individual elements can be set within 
a page using the familiar tools in the 
Properties toolbar.

e.g. <h1 style=”
color:#00F; 
margin-right:20px;”>

This is a heading.
</h1>

Session 4.11 Creating stylesheets using website authoring software
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This however is a very general rule; the more specific a rule is, and its placement 
within the HTML is also a factor. For example if an external style sheet is placed 
after an internal one in the HTML coding, the external one will have priority. You can learn more about web 

colours in the Extra support folder on 
the CD.

Tip

On the CDYou should now be able to:
 � understand the difference between internal and external HTML 

styling
 � understand the reasons why web developers use cascading 

stylesheets
 � describe the different elements that can be defined by stylesheets
 � create and apply external stylesheets to a webpage
 � explain in general terms the order in which styling is applied to a 

webpage when viewed through a browser.

Review and revise
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Using website authoring 
software [2]SESSION 4.12

Background
You are now going to apply what you have learned and build on it by using tables to organise the layout 
of the webpage. You will also learn how to insert an image and a hyperlink, and keep text and images well 
organised when viewed in a browser. You are also going to use the skills you learned in the previous session 
to create and apply external style sheets to your website.

Using tables to organise webpages
Junaid needs to add four extra pages to the website in addition to Page 1a. He has asked you to put 
together these pages.

5. Consumables

A4 paper
image

Details Price

B+W ink
image

Details Price

Colour ink
image

Details Price

3. Printers

All-in-one
image

Details Price

B+W Laser
image

Details Price

Colour Laser
image

Details Price

4. Monitors

Details Price

Details Price

Details

19" image

23" image

25" image Price

2. Computers

Laptop
image

Details Price

Desktop
image

Details Price

All-in-one
image

Details Price

So let’s make a start with page 2. To create a new empty page select File > New > Blank Page > HTML > 
Layout <None> and then Create. Once you have created the page, select File > Save As and place it in the 
website folder as Page1a.

Begin by typing the heading for Page 2. You can see from Junaid’s outline that it should be Computers. Now 
you can insert a table. You can either select Insert and Table from the main menu, or select the table icon 
from the common items in the right-hand menu on the Dreamweaver screen.

Each page has:

 � a table with three columns 
and four rows, the top row is 
merged

 � a title in the top row

 � three images

 � three sets of details

 � a discounted and original price 
for each item.

The table requires four rows and 
three columns. Set the width to 
100 per cent (the whole page) and 
the border, padding and spacing 
to 1. These will be discussed later.
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Table properties
A table like the one you have created can be formatted much in the same way as a table within a word 
processing document.

Inserting an image in a webpage
With the table created, it is time to insert an image. Choose Insert > Image from 
the main menu. You can then browse for your image and add alternate text. 
This alternate text (Laptop) will appear as you hover your mouse over the image 
when previewed in a browser.

1 Copy the laptop image from the CD into the media folder within your website folder.

2 Create Page2.html as shown with a three column, four row table, with the top row 
having been merged into one cell, and insert a laptop image.

3 Cut and paste the Computers title from the top of the page into the merged top row 
of the table.

Activity 1

Image sizes in webpages
When you browse any webpage with images, the images will not display properly 
until your computer has downloaded a copy of them. This means your browsing 
speed is often affected by the file size of images within a webpage and how fast 
your connection can download them. Digital images are measured in pixels and 
whereas the physical size and pixel resolution are considered when printing, only 
the pixel size is important in web design. A standard computer screen has a size of 
1024 x 768 and upwards, and images should be scaled with this in mind.

Manipulating an image
Ideally, images for use in websites should be formatted so that their size matches 
the available space within a webpage. There are a number of software packages available that can perform 
image manipulation and a variety of image file types than can be used in web design. The following steps will 
guide you through using an open source software package called Gimp.

By clicking into one cell, top left 
for example, and dragging the 
cursor into the two cells to the 
right of it, they are all selected. 
Then select Modify > Table and 
Merge Cells to create a single 
large cell.

Selecting the table on the 
right hand displays the table 
properties bar. Here the size, 
number of rows/columns and 
how text is aligned within 
different area can be set.

Selecting within a cell and its 
contents can be positioned 
within each cell using the Horiz 
and Vert options, along with the 
colour of each cell.

On the CD

Images for using in your web design 
work throughout these practical 
sessions are available on the course 
CD, but before using them, copy them 
to your local document website folder 
to keep links relative. This means they 
will always appear in your website, 
even after the CD is removed.

Tip

Inserting alternate text for an image 
is really important for businesses. 
It allows those with partial sight to 
have image descriptions to read, and 
it helps businesses get their sites 
noticed as the image descriptions are 
read through by popular internet 
search engines.

Real world
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Image editing terminology
The following terms are often used in image editing.

Term Description

Resizing Changing the size of an image without editing its resolution; this 
normally relates to printed work and not internet images.

Resampling Changing the pixel height and width of an image; relevant to 
internet use, as sizes are measured in pixels.

Colour depth Refers to the number of colours that can be stored for a 
particular image. It is measured in bits and this relates to the 
number of computer memory bits that can be used to store 
colour information.

 � 2-bit allows four colours
 � 4-bit allows 16 colours
 � 8-bit allows 256 colours
 � 16-bit allows 65,536 colours
 � 24-bit allows 16,777,216 colours.

Image 
resolution

Normally measured in pixels per inch (ppi). The higher the value 
the greater the detail. Screen resolution is normally 72 or 96ppi, 
while 300ppi is recommended for professional printing.

Aspect ratio The ratio between the height and width of an image. By 
maintaining or fixing an aspect ratio an image will look the same 
and not stretched when resized or resampled.

Resizing an image
The following high-quality image needs resampling in order to fit into the cell of a 
table that is 200 by 200 pixels.

Open the image in your software 
and select Image > Scale 
Image. The size of the image can 
now be changed to fit within the 
required area.

Entering 200 pixels as the width will 
automatically scale the height. The 
size is now 200x150 pixels.

The chain symbol means 
the aspect ratio is locked.

As lower cost high resolution 
monitors become more commonplace, 
the screen resolution of webpages 
is obviously increasing. A full HD 
screen for example has a resolution 
of 1920 x 1080. However with more 
smartphones and tablets displaying 
webpages, pages are having to be 
developed that can adapt to a range 
of different sizes. This is often referred 
to as adaptive or responsive web 
design.

Real world
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Find a suitable image from the internet of a desktop computer, but do not use the one on the course CD. Resample the image to 
the following approximate size: 250 pixels wide by 200 pixels high.

Activity 2

Changing the colour depth
The standard colour depth for internet images is 256 colours or 8-bit. This can be adjusted and the lower the 
colour depth the smaller the file size. It should be noted though that lowering the colour depth will result in 
loss of image quality.

Experiment with the colour depth of your image from Activity 2. At what colour depth does the quality of the image become 
unusable?

Activity 3

Saving in different file types
When saving image files for use in websites it’s important to choose correctly. The following are common file 
types.

Image file type Description

JPEG (.jpg) (Joint Photographic Experts Group) Designed for flat, rectangular images. Lots of 
compression options and the quality of the image can be selected when saved.

GIF (.gif) (Graphics Interchange Format) Limited to 8-bit, this file is often used for diagrams or 
cartoon-style images. Also used in animation. Images can also have transparent areas.

PNG (.png) (Portable Network Graphics) Similar to a GIF file but can support 16 million colours and 
therefore higher-quality images.

BMP (.bmp) (Windows Bitmap) Uncompressed images created in the Microsoft Windows operating 
system. File sizes are often too large for internet use.

Select File > Save As and then 
your chosen file type. You will 
normally also be presented with 
secondary options for colour 
and compression levels.
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Experiment with image files by resaving the original image file you found from the internet in 
Activity 2 into the four file types listed. Discuss with a partner the differences, if any, between 
the saved files. Use the image you resampled in addition to or instead of one of the images 
included on the CD in your website.

Activity 4

Compression allows smaller file sizes 
to be created but this reduces the 
quality.

Tip

You are going to complete Page 2. Refer back to Junaid’s outline at the beginning of the session.
1 Find the image of the all-in-one computer on the course CD.

2 If necessary, resize it, adjust the colour depth and amend the file type.

3 Insert the image, along with the image of the desktop computer you edited in the previous activities, into Page 2.

4 Try to find some up-to-date information online for the details of each type of computer. Insert the text into the correct cells of the table.

5 In the third column, type some prices stating what the old price was and what the price is now. You might refer to where you found the 
details of the computers. Format the old price to strong and select the strike-through option from the Format > Style option on the 
main menu.

6 Attach the stylesheet you created in the previous session and use appropriately: ACSupplies.css. Choose Format > 
CSS Styles > Attach Style Sheet and add as a link.

Your final page should look similar to this:

On the CD

The attached style sheet 
rules can be seen here.

Add a suitable title to the page, this 
then shows at the top of the browser 
when previewed.

Activity 5
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Inserting sound, video and moving images
Websites often used sound, video or animated images to enhance their website. Junaid has asked you to 
experiment with adding some multimedia content to Page1a.html.

Copy the sound and video from the CD into the media folder within your website folder. The example below 
shows how sound and video can be inserted within Dreamweaver.

Select Insert > Media > Plugin and browse for the Mp3 file in your media folder and press OK. The symbol 
that appears on screen will represent a media controller when previewed so it needs to be increased in size 
using the corner handles.

Once inserted, stretch the icon so 
that the controller will be visible in 
the preview screen.

Audio controller

Inserting video is done in exactly the same way: Insert > Media > Plugin. Enlarge 
the icon that appears to the size you would like the video to appear.

1 Insert the sound and video in your media folder onto Page1a.html, and experiment with 
size of the icon to be the most efficient and accessible for the viewer. Remember to 
preview the page within a browser to check the playback.

2 Use the internet to try and find some additional files that could be added. However it’s 
important to justify any files you add, thinking of the aim of the the web site and its target 
audience.

Activity 6

Changing the layout of the table
You need to change the page because you do not want people to see the table 
border when they are looking at the webpage in a browser:

 � Go to Views > Code
 � Find the line that says: <table border=“1” style=“width: 100%”>
 � Change this to: <table border=“0” style=“width: 100%”>
 � The example below illustrates the change you should see.

Mp3 and wav files are popular sound 
file choices and Mp4 files are most 
commonly used for video when 
adding to webpages.

Tip

Rather than take up file space within 
their own websites, many web 
designers now prefer to embed 
content from other sites. Videos, 
music, games, animation, maps and 
utilities can be added to a site with 
only a few lines of code. Popular 
sites like YouTube and Vimeo offer 
embed codes that can be added to 
your HTML code.

Real world
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Sometimes the layout of a table can be improved by using cell padding and cell spacing. Cell padding is the 
space between the cell contents and the border. You should see that the first line of each description is right 
at the edge. Cell spacing increases the space between each cell in the table. You can change this by adding 
some extra space.

 � Make sure that you can still see the HTML source code (Views > Code).
 � Find the line that says: <table border=“0” style=“width: 100%”>.
 � Place your cursor after “100%” but before > and type: rules=“all” cellpadding=“4px” 
cellspacing=“5px”

This adds 4 pixels of space between the cell contents and the cell border and also increases the space 
between each cell in the table by 5 pixels.

You can also set the size of the table to a specific width of the screen. At the moment, the table you have 
created fills the whole screen. You can set it to a percentage of the screen.

Go back to the line you have just changed and place your cursor after “5px” but before > and type: 
width=“80%”. This changes the width of the table to 80 per cent of the screen.

Then, because the pictures look untidy with all that white around them, you could to change the CSS 
stylesheet to match the background to the same white colour:

1 Open the file ACSupplies.css.

2 Find the line that includes: background-colour and change it to: #FFFFFF.

3 Select File and Save All to save all files.

Try creating Pages 3 (Printers), 4 (Monitors) and 5 (Consumables). Follow the steps that you took to create Page 2 (Computers). 
Look online for suitable copyright-free images of each product and the up-to-date information you need to be placed in the cells 
for the details of each product. Don’t forget to add the prices as you did for Computers in Activity 5. If possible, try to find an 
animated image to represent one of your products. Tip: This will probably be an animated gif and inserted in just the same way as 
an image.

Activity 7

On the CD
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Inserting hyperlinks
Now you need to link all the pages together. Open Page1a.

Linking files is done by inserting a hyperlink to another page, document or website. You will see the same 
term can be used in spreadsheet models, presentations and desktop publishing documents.

1. Highlight the word Computers.

Relative and absolute file paths.
This option allows you to choose either a relative 
(Document) or absolute (Site Root) file path. 
Choose the Document option (more below).

3. Browse for Page2.html.

2. Click on the folder link icon 
for Insert > Hyperlink > Select 
Folder from main menu.

4. Click OK

Using and inserting bookmarks
Creating a bookmark is the process of saving a particular website title and URL address in order to revisit 
it. Modern website browsers have this functionality and will create a bookmark and add it to a list of saved 
addresses you can access at any time.

This process isn’t limited to home pages, it can be used to link to any particular page within a website and 
also to a specific location within a single page, especially useful if a content rich page is very long.

Consider a product long listing page within the All Computer Supplies website that contains lists of laptop, 
desktop and tablet computers. Users may wish to jump down to the tablet section. At the point in the page 
where the tablet computers start, you could add the following lines to the HTML.

1. Create a bookmark within 
the page at the point at where 
the tablet computers would 
start using the id attribute.
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Relative and absolute file paths
A relative file path gives a directory listing in relation to the file it is being linked to. For example Page1a.html 
and Page2.html are in the same folder so the link would be simply Page2.html.

If we consider the photo of a laptop of Page2.html then the relative link of that image from Page2.html would 
be as follows:

<img src=“media/Laptop.jpg”

HTML code for image 
location or URL (img src)

This means look in the folder 
called media in the same locaton 
(no file extension for folders)

Look for a file called Laptop.jpg 
in the folder called media

An absolute (full or root) file path provides a complete directory listing for the 
location of a file when creating links. For example the absolute file path of the 
same image would be:

<img src=“C:/Users/Public/Documents/Website/mediamedia/Laptop.jpg”

This goes right back to the main computer c: drive

It is therefore more efficient to use a relative file path when considering website 
design. As you will see in the next session, only the folder containing the 
website would be uploaded to an online server is the site went online therefore 
any absolute references relating to c: drives would not work correctly.

To do the same with Page 3 (Printers):
 � Highlight the word.
 � Click on the Link icon.
 � Browse for Page3.html.
 � Click OK.

Anchors
An anchor is a specific link within a webpage using a hyperlink. These are used 
in long pages with lots of content on the same page such as an instructional 
guide or online story that requires chapter points.

To define an anchor point: Select Insert > Named Anchor from the main 
menu and give it an appropriate title (single word in lower case). 

If a hyperlink is linked to a folder 
higher up in a directory tree than 
below it as shown in the example, 
then the movement up the file tree is 
represented by ‘../’. For example an 
image placed in a webpage from a 
folder two levels above it would have 
a path of: ../../Laptop.jpg

Tip

As anchors are locations on a web 
page rather than an object, they 
cannot be seen when the page is 
previewed within a browser or Live 
view. They can only be seen when in 
Design view.

Tip

Although not a problem when 
developing websites on a local 
computer, file paths online are 
generally case sensitive, so it is 
good web design practice to use 
lower-case for all folders and 
filenames when creating any web 
projects. Notice the capital L for 
Laptop in the example shown. If the 
hyperlink was manually typed with 
a lowercase l then it may not work 
correctly if uploaded to the internet.

Real world

3. By adding the specific web page to the hyperlink, the 
bookmark can be linked to from another page.2. At the top of the page, add 

a hyperlink to the bookmark.
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Open Page2.html and under the price of the laptop computer, add the term Important Notice. Then click 
the cursor below the table of computers and press Return at least ten times to add a space. Insert a Named 
Anchor from the Insert menu and give it the title notice. This should then appear as an anchor symbol on the 
page below the table. Next to the anchor, add the following message in italic:

Prices are correct at the time of the website being written, please confirm when ordering.

Select the Important Notice text under the price and then Insert > Hyperlink from the main menu. From the 
Link option the anchor should be listed as #notice, select this and press OK.

1 Now add the hyperlinks for Monitors and Consumables (Pages 4 and 5).

2 Add Important Notice anchors to each of your products.

3 When you’ve done this, save your work by selecting File > Save All from the drop-down menu.

Activity 8

Creating an external link
An external link works in exactly the same way as an internal link but takes the user to an online webpage 
rather than a local one.

To create an external link: Select the text or image from which to link and select Insert > Hyperlink or type 
directly into the Link box in the Properties toolbar. Enter the full URL (including http://www) and select OK 
or press Return if you are using the Link box.

You have decided to add some background information to each of the products to help buyers make a 
decision. The Wikipedia (http://en.wikipedia.org/wiki/Laptop) page on laptops provides useful information so 
you are going to add it as a link underneath the Important Notice link. You’ve also decided to have the link 
to an external site open in a new window rather than the existing one.

Target set to Blank (New 
Window)

Text selected before 
inserting link

Full URL pasted into Link box

Choosing a hyperlink target
When linking from one webpage to another the default option is to simply open in the same page. The Target option 
provides the following alternatives:

Target Option Description

_Blank Opens the linked file or webpage in a new browser window

New Opens the linked file or webpage in a new browser tab

_Parent Opens the linked file or webpage the parent frame or parent window if frames are used. Note: Frames 
are not commonly used now in web design as they can cause browser problems, especially with mobile 
devices.

_Self Opens the linked file or webpage in the same window or tab. This is the default option.

_Top Opens the linked file or webpage in a new full window, removing any frames. Again frames are not used 
in modern web design.
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The first page of any website is 
normally referred to as the home 
page and is normally given the 
file name: index.html. This is the 
filename web browsers look for 
having been directed to a web server 
containing web pages.

Real worldAdding an email link
Junaid would like you to add an email link to the home page (Page1a.html) 
of your website. He would like the site to say: Contact ACS via email 
and when users click the address that it opens a new email message 
to junaidacs@allcomputersupplies.com in their default email program.

Select your text on screen 
and choose Insert > Email 
Link from the main menu.

Add the email address 
to the box provided and 
press OK.

Alternatively the HTML code 
for adding an email address is: 
mailto:addemailaddresshere

1 Add background information using external hyperlinks and internal anchor points to all of your webpages.

2 For each of Pages 2, 3, 4 and 5, add an extra row of three cells to the bottom.

3 Browse the course CD for the image home button.jpg.

4 Insert the image in the centre of the bottom middle cell of each page. This icon represents the homepage (Page1a) and needs 
linking to that page.

5 Add a hyperlink to the homepage icon for each of Pages 2, 3, 4 and 5.

6 Add the email link shown to the home page of your site.

7 Rename the first page of your website to index.html. You will have to check and change some of your hyperlinks accordingly.

Activity 9

You should now be able to:
 � create additional web pages and attach style sheets to them
 � use and format tables to organise a webpage
 � insert and organise images, sound and video
 � resample, resize and format images suitably for internet use
 � add internal and external hyperlinks to webpages
 � understand the difference between relative and absolute file paths
 � insert and link to webpage anchor points
 � insert email links to webpages.

Review and revise
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Testing and publishing 
a website

206 Unit 4 Networks and the effects of using them

SESSION 4.13

Background
In this session you will find out how a website created 
locally in your home, office or school computer can be 
uploaded to the World Wide Web for everyone to see. 
But before that, your site should be tested to make sure 
everything works correctly.

Testing a website
It’s difficult to edit a webpage after it has been uploaded 
to the internet so thorough testing beforehand is essential. 
Rather than just the simple question of “Does the site 
work?” a website can be broken down into its content, 
features and functionality in order to write a test plan. 
Consider the following elements:

Website element What can be tested?

Text Spelling, grammar, suitability of language, font choices

Images Clarity, quality of image, suitability, image file size

Hyperlinks Internal and external links, anchor points

Media files (sound, 
video or animation)

Clarity, quality of media, suitability, file size, playing of media content

Consistency Use of CSS files, commonality of styles across pages

Accessibility Image descriptions, browser text accessibility tools, including zoom and speech

Browser compatibility Appearance in different browsers, including mobile devices

Creating a test plan
A test plan is a way of formalising a series of tests to be carried out before any 
system is made available to a wider audience. This is not just limited to web 
design, the same method can be used for publishing, spreadsheet modelling, 
database design or game building. A test plan asks the user to consider what 
might, should and actually does happen when others use the site, ideally 
previewed within a browser. An example of a test plan with two example tests is 
shown on page 210.

Technical testing and functionality 
can produce more problems than 
accidental mistakes made during 
a website’s construction. Websites 
can be created in many ways, using 
a wide range of hardware, software 
packages and operating systems, and 
are then expected to integrate with 
hosting systems running as many 
different systems again. Many would 
consider it miraculous that anything 
works at all!

Real world
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Test number Description of 
test

How can it be 
tested?

Expected result Actual result Action required

1,2… Describe what 
part of the 
website is going 
to be tested.

What method 
could be used, 
simply clicking a 
link or watching 
a video or 
proofreading the 
text? 

What should 
happen when you 
click a hyperlink 
for example?

Describe what 
actually happens, 
even if it was 
the expected 
outcome.

If you fail a test, 
what needs to 
be done, re-
do a hyperlink 
for example 
or replace an 
unsuitable image. 
If nothing is 
required simply 
add none 
required.

1 Content 
hyperlinks on 
Page1a.

Ask a test user to 
try all the links in a 
browser.

I expect all the 
links to work 
correctly.

The Printers 
hyperlink actually 
took me to the 
Computers page.

Delete the 
hyperlink on 
Page1a and 
replace it.

2 Check the quality 
of the printer 
images on 
Page 3.

Ask a user to look 
at the images and 
confirm they are 
clear and suitable.

I chose the image 
carefully and 
resized it so it 
should be OK.

The test user says 
the images are 
clear.

None required.

1 Create a test plan like the one shown that covers all elements of the site you have created for 
Junaid. Try to cover all the elements covered at the beginning of this session.

2 Carry out each of the tests, making sure to note any problems and how they could be 
resolved.

3 Carry out any action points generated in order to pass all of your tests.

Activity 10

Publishing a website
In order for a wider audience to access a website on the internet then it needs 
to be published, or uploaded, to a web server or hosting company.

A web hosting company will provide file storage space on their servers that are 
directly connected to the internet, in order for any web designer to upload it. 
One of the most common methods is to use File Transfer Protocol (FTP), this 
provides controlled access to a specific file space in order to copy files from a 
local computer to the web server.

Large international websites may 
need file space and processing power 
far and above that offered by a 
traditional hosting company. A server 
farm is a purpose built collection 
of multiple networked servers that 
are connected together to provide 
centralised access to a large internet 
connected system. 

Real world

207Session 4.13 Testing and publishing a website
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Your hosting service will 
provide you with the 
following:

 � An ftp address

 � A username

 � A password

Here you will navigate to the 
correct folder on the hosting 
web server.

This windows displays server 
connections, letting you know when the 
hosting site has been accessed.

Here are the files contained within your 
website folder.

Drag and drop

You should now be able to:
 � understand the need for website testing
 � describe the main elements of a website that can be tested
 � write and carry out a test plan to ensure a website is suitable for its intended audience
 � improve a website in response to failed tests if required
 � understand how FTP works in relation to web design.

Review and revise

The example below shows a piece of open-source software called FileZilla. It allows a user to connect to a 
remote web space in order to upload their files.
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You are going to create a website for Colin, who owns a 
shop that sells and buys coins and banknotes.

1  Create a new folder called COLINCB in your 
personal folder.

2  Download the relevant source files for this review 
section from the CD into your folder.

3  Open the stylesheet CCBShop.css with website 
authoring software.

 � Change the background colour so that it has no 
blue element.

 � Change the font size of <h1> to be 24px.
 � Save the stylesheet with the name CCBShopB.

css in your COLINCB folder.

4  Using a suitable software package, create a new 
webpage called CCBShop.html.

Create a structure that will look like this, using a 
table:

A

B

C

D E

F G

H I

J

5  Attach the stylesheet CCBShopB.css to this 
webpage.

6  Set the table width to 95% of the width of the 
window.

7  Set cell spacing and cell padding for the table to 4 
pixels.

8  Using the contents of the file CCBText.txt:
 � place the text: Welcome to Colin’s Coin & 

Banknote Shop into cell A as style <h1>
 � place the text: Visit these recommended … 

Banknote Dealers into cell B and format 
this as:

 � Visit these recommended sites – as style 
<h2>

 � The International Banknote Society (IBNS) – 
as style <h2>

 � Professional Coin Grading Service – as style 
<h2>

 � Numismatists Directory – as style <h2>

 � Rare Coin Dealers – as style <h2>

 � Banknote Dealers – as style <h2>
 � place the text: Colin’s Coin Shop is one of the 

north of England’s ... area of the dealership into 
cell C as style <p>

 � place the tex:t Treasury Notes … 1949–1962 into 
cell H with each of the five lines as style <li>

 � place the text: Hammered coins … 
1658–date into cell I with each of the 
lines as style <li>.

9  In cell D, enter the text Banknotes as style <h2>.

10  In cell E, enter the text Coins as style <h2>.

Some practice questions
All relevant files can be found on the CD.

On the CD

What have you covered?
In these four practical sessions, you have:

 � seen how a webpage is structured in HTML
 � practised the use and effect of a wide variety of <tags>
 � investigated the creation and use of cascading style sheets
 � created style sheets and seen how to attach them to a webpage or webpages
 � investigated the creation of tables as a way to help organise webpage content
 � added tables to a web page and formatted them
 � practised adding content (text, images and multimedia content) to your webpage and applying styles
 � discovered how to create hyperlinks from text or images and create internal hyperlinks using anchors
 � written a test table and applied the tests to your webpages
 � investigated how websites are uploaded to the Internet using FTP.
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11  Using the Internet, search for an image of an old 
bank note. Save it as Banknote.jpg and insert it 
into cell F. Set the width to 300 pixels and maintain 
its aspect ratio.

12  Again using the Internet, find an image of an old 
coin. Save it as Coin1.jpg and insert it into cell G. 
Set the width to 150 pixels and maintain its 
aspect ratio.

13  Add the following text in style <p> to cell J at the 
bottom of the table: last edited by (your name).

14  Search the internet to find the URL of the home 
page of the International Banknote Society. Create a 
hyperlink from the text: The International Banknote 
Society (IBNS) in cell B with this URL, so that the 
IBNS home page opens in a new window called 
_ibns.

15  Create a hyperlink from the image in cell G to open 
the file CCBCoins.html in a new window called 
_CCBcoins.

16  Save the page CCBShop.html.

17  Using a suitable software package, open the 
webpage CCBCoins.html.

18  Attach the stylesheet CCBShopB.css that you 
saved at step 3.

19  Replace the text Heading here with the text 
Hammered and Milled Coins as style <h2>.

20  Replace the text Colin Derbyshire, 01/03/2015 with 
your name and today’s date.

21  Write a test plan that will cover all the major 
components of your webpage.

22  Carry out your test plan and make any 
improvements that are needed after these tests.

23  Take a screenshot of the webpage CCBCoins.html 
and save either as a .jpg file or as an insert into a 
word processed document.

24  Save and print the page CCBCoins.html.

Progress check

Aiming for good progress
 � Given an outline, you can 

successfully create a webpage’s 
structure with a table.

 � You are able to attach a style 
sheet to a webpage.

 � You are able to add content (text, 
images or multimedia elements) 
to the webpage.

 � You can apply styles to text.
 � You can create a hyperlink to 

another webpage or website.
 � Link directly to an email address 

from a webpage.
 � You can test the basic elements 

of a webpage.
 � You can describe how to upload 

information to a web server.

Aiming for excellent progress
 � Given an outline, you can successfully create a webpage with a table.
 � You can create and edit a style sheet as required and attach a style 

sheet to a webpage.
 � You are able to add content to a webpage and, when inserting images, 

either crop or resize them as required.
 � You can add styles to text and use heading and paragraph options.
 � You can link directly to an email address from a webpage.
 � You are able to control the appearance and content of a table cell using 

alignment, merged cells, cell spacing and cell padding.
 � You can create hyperlinks to other webpages using relative file paths 

and control how they appear.
 � You can create anchors to move to other positions within a webpage.
 � You can write a detailed test plan and use it to test a website.
 � You are able to explain how to upload information to a web server and 

the importance of file structure.
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